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Main Features

� New and improved microphone system reduces extraneous sounds such
as wind or machine noise created while recording and thus enabling a
higher quality of sound recording than ever before.

� New design and location of buttons enable single-handed control without
ever having to visually check the placement of function buttons. Directrec
fits easily into your hand providing effortless control coupled with superb
dictation experience (�P.4).

� The Directrec has 2 programmable (A,B) buttons (�P.29,30).

� All button functions are easily customized to suit a particular preference
or any recording environment (�P.29-33).

� USB Audio Device Directrec, can be used as a USB microphone or USB
speaker when connected to a PC. In addition, a powerful built-in speaker
provides hi-fidelity acoustic playback.

� Directrec can be used as a remote-control for the DSS Player Pro (referred
to as DSS Player from now on) not only for direct recording, but also
when editing recorded files on a PC.

� Directrec can save a recording as a file on a PC in DSS (Digital Speech
Standard) format.

� Two recording modes, SP (Standard Playback) mode or LP (Long
Playback) mode (�P.20).

� Microphone sensitivity can be adjusted to better suit recording
conditions and environment (�P.20).

This product is equipped with the following features.

• OLYMPUS IMAGING CORPORATION holds the copyrights for DSS Player
Pro software and the instructions (this manual).

• Microsoft and Windows are registered trademarks of Microsoft Corporation.

• Intel and Pentium are registered trademarks of Intel Corporation.

• Other product and brand names mentioned herein may be the trademarks or
registered trademarks of their respective owners.
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1 Built-in microphone
2 Record/Play indicator light
3 PLAY button/STOP function
4 NEW button
5 A (Programmable) button
6 REW (Rewind) button
7 REC (Record)/STOP function
8 FF (Fast Forward) button
9 Left mouse button
0 Pointing device
! Right mouse button
@ Built-in speaker
# B (Programmable) button
$ USB cable

Identification of Parts

How to use the pointing device

Hold Directrec gently and use your thumb to
move the pointer to your desired direction. To
click, use the pointing device right or left button
as your would with a PC mouse. Please do not
press or move the pointing device Forcefully.

@

4

3

6

9

0

1

5

8

!
7

#

2

$ Tip on the pointing device

Holding Directrec gently and using a thumb can
control the pointer like a PC mouse.
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Minimum Requirement

IBM PC/AT compatible PC

Microsoft Windows Me/ 2000 Professional/
XP Professional,Home Edition

Intel Pentium II class 333 MHz processor or faster
(Processor 500 MHz or faster is recommended)

128 MB or more (256 MB or more is recommended)

50 MB or more

2x or faster CD-ROM, CD-R, CD-RW, DVD-ROM drive

Creative Labs Sound Blaster 16 or 100% compatible
sound card

Microsoft Internet Explorer 4.01 SP2 or later

800 x 600 pixels or more, 256 colors or more

One or more free ports

PC:

Operating System:

CPU:

RAM:

Hard drive space:

Drive:

Sound card:

Browser:

Display:

USB port:

Make sure that your computer meets the Minimum requirements listed
below. Please check with your system administrator or your Olympus
Professional Dealer.
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Installing DSS Player Software

1 Insert Olympus DSS Player CD into the CD-ROM drive.
The installation program will start automatically.
If the installation program does not start automatically, browse your CD-ROM
drive and execute “setup.exe”.

2 The installation Language Selection dialog box appears.
Select the desired language.

3 Register user information.
Enter your name, company name, and license ID number (serial number).
The license ID number is printed on the license ID card included inside the
recorder package.
Click the [Next] button. When a confirmation dialog box appears, click the [Yes]
button.

4 Proceed with the installation according to the instructions on the
screen.

Before you connect your Directrec to your PC, you must first install the
DSS Player software.
Make sure to exit all running applications, eject the floppy disk if you are
using one, and logon as administrator if you are running Windows 2000/
XP (Professional only) on the network.
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Uninstalling DSS Player Software

1 Exit DSS Player program.

2 Click the [start] button on the taskbar.

3 Select [Add/Remove programs] from the [Control Panel].
A list of installed applications is displayed.

4 Select [Olympus DSS Player Pro], then click the [Change/Remove]
button.

5 Proceed with the uninstallation according to the instructions
on the screen.

To uninstall any of the software components of the DSS player software
installed on your PC, follow the steps below.

..............................................................................................................................

Note
• Uninstallation does not erase the stored dictation files.



8

For information on the DSS Player usage and features, refer to the
online Help.
To start online Help:

Using Online Help

• Click the [start] button, then select [All Programs], [Olympus DSS
Player Pro], [Dictation Help].

• While DSS Player is running, select the [Help] menu, [Contents].

• While DSS Player is running, press F1 on the keyboard.

......................................................................................................................................

Note
• For more information on menus and operations, refer to Online Help. Online Help is

available after the DSS Player is installed.
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Connection to Your PC

Be sure to install the DSS Player software before connecting the
Directrec to the PC. However, if you do connect the Directrec before or
during the software installation, the “Add New Hardware Wizard” will
appear. In this case, cancel the wizard by pressing the [Cancel] button
in the wizard screen and then install or continue the installation of DSS
Player software.

Disconnecting from Your PC

..............................................................................................................................

Notes
• Some PCs and USB hubs may not supply sufficient power and the Directrec fails to

connect. Refer to your PC User’s Manual regarding the USB port or USB hub on your PC.
• When using a USB hub to connect the Directrec, always use a self-powered (AC adapter)

USB hub.
• Never disconnect the USB code while the record/play indicator light is flashing. If you do,

the data will be destroyed.

Connecting to your PC Using the USB Cable

1 Connect the Directrec USB
cable directly into the USB
port or USB hub of your PC.

1 Disconnect the Directrec USB cable from your PC USB port or
USB hub.
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Running DSS Player

Disabling automatic start

1 Right-click the Device Detector icon    in the System Tray in
the lower right hand corner of the screen, then select “Settings
startup application”.

2 Click [DSS Player Pro].
The check mark on [DSS Player Pro] disappears.

By default, connecting the Directrec to your PC will start the application
automatically.

1 Start Windows.

2 Click the [start] button, then select [All Programs].
All program menus will be displayed.

3 Select [Olympus DSS Player Pro], then click [Dictation Module].

Manual start

......................................................................................................................................

Note
• If you connect the Directrec before installing DSS Player, the “Add New Hardware Wizard”

dialog box will open. If this happens, click [Cancel] to exit the wizard, then install the DSS
Player software.

2 3
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Window Names

1 Playback Control Bar
Provides the control buttons to play and stop dictation files.

2 Dictation Tree View
Displays the directory structure of the DSS, WAVE -format files stored on
your PC’s hard disk.
Recordings made using Directrec will be saved as a file in the Message Tray
( ) in the Dictation Folder ( ).

3 Device Tree View
Displays the directory structure of the Directrec.

4 Dictation List View
Displays the dictation files in the folder selected in 2 and 3.

1

4
2

3

Massage Tray

Main Window(Windows XP)

* Main screen is displayed when DSS Player is started
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Using the Remote Edit Window

Starting the [Remote Edit] window for the DSS Player main window

1 Ensure Directrec is properly connected to your PC and then start
the DSS Player.
DSS Player main window appears.

2 From the DSS Player main window, click the [File] menu, then
select [New File...], or click the  icon.
[Remote Edit] window appears.

3 Directrec button functions are completely supported when the
[Remote Edit] window is open.

......................................................................................................................................

Notes
• Ensure that the [Remote Edit] window is open when you use Directrec, or the remote

control will not function.
• The [Remote Edit] window can also be displayed without opening the main menu when

starting the DSS Player (�P.13).

For enjoyable recording experience, use Directrec with the DSS Player
software to record to your PC. The DSS Player can be configured to
provide you with complete remote control over your recording session
from the Directrec without the use of the PC mouse.
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Starting the [Remote Edit] window without opening the DSS Player main window

With a push of a button on the Directrec, you can set your PC to open
the [Remote Edit] window directly without entering the DSS Player main
window.

1 From the DSS Player main window, click the [Tools] menu, select
[Options...], then click the [Direct Dictation] tab.

2 Check [Start Remote Edit window automatically when Dictation
Module is launched] and then click the [OK] button.
The pre-settings are now complete.
When pre-settings are checked, the computer recognizes the Directrec device
connection as the DSS Player starting, and opens the [Remote Edit] window
without opening the main application window (�P.11).

Window

2



14

Direct Recording

1 From the DSS Player main window,
click the [File] menu, then select [New
File], or click the  icon.
[Remote Edit] window appears.

2 Press the REC button on the Directrec
or press the  (Record) button
in the [Remote Edit] window to start
recording.
The red record/play indicator l ight on
Directrec will become lit. Point the micro-
phone at the sound source.

3 Press the REC button on the Directrec
or press the  (Stop) button in
the [Remote Edit] to stop recording.
If you want to append additional recordings
to the same file, Press the REC button on
the Directrec or press the  button again.

New Recording

2,3

Current recording
time

Remaining recording
time

2 3
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Overwrite Recording

You can overwrite a previous recording from any point within the file.
Note that the overwritten recordings will be premanently erased.

1 Make sure you are at the starting point
of the recording to be overwritten.

2 Press the REC button on the Directrec
or press the  (Record) button
in the [Remote Edit] window.
The record/play indicator light on the Directrec
will light up and Overwrite Recording will start.

3 Press the REC button on the Directrec
or press the  (Stop) button in
the [Remote Edit] window  to stop
overwriting.

......................................................................................................................................

Notes
• Ensure that the “Insert recording” box (�P.16) in the [Remote Edit] window is not checked

or the overwrite recording will not proceed.
• You cannot select a different recording mode (SP, LP) than that of the original file before

overwriting a recording.

2,3

2 3

Do not check here.
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Insert Recording

Additional recording can be inserted into a previously recorded file.

1 Check ( )“Insert recording” box in the
[Remote Edit] window.

2 Make sure you are at the right position
in the file where recording insert
should take place.

3 While playing the file, press the REC
button on the Directrec or press the

 (Record) button in the [Remote
Edit] window to start inserting an
additional recording.
The red record/play indicator light on Directrec
will become lit.

4 Press the REC button on the Directrec
or press the  (Stop) button in the
[Remote Edit] window  to the stop
inserting the additional recording.

3,4

......................................................................................................................................

Notes
• Ensure that the “Insert recording” box in the [Remote Edit] window is checked or the

recording will not be inserted.
• You cannot select a different recording mode (SP, LP) than that of the original file before

overwriting a recording.

Direct Recording

3 4

1
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Playback (Playing a Dictation File)

1 Press the PLAY  button on the
Directrec or press the  (Play)
button in the [Remote Edit] window
to start playback.
The green record/play indicator light on
Directrec will become lit.

2 Adjust the volume slider in the
[Remote Edit] window to the required
level.
The recording will be played through the
Directrec speaker.

3 Press the PLAY  button on the
Directrec or press the  (Stop)
button in the [Remote Edit] window
at any point you want to stop the
playback.

1,3

2

3 1Playback slider
Shows the current
playback position

Time axis

Current playback
time

Total recording time of
the file being played
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Playback functions

Operation

Press the FF button once while
stopped.

Press the REW button once while
stopped.

Hold the FF button while stopped or
playing a file.

Hold the REW button while stopped
or playing a file.

How to Cancel

Press the PLAY button.
➥ The Directrec starts the

operetion of the set position.

Release the FF button.

Release the REW button.

Playback

functions
Fast Forward
(FF)

Rewind (REW)

Cue (CUE)

Review (REV)

• Please refer to our Online Help for further information about Directrec functions and controls
(�P.8).

Various functions are available with Directrec and the [Remote Edit]
window to playback a recorded file.

Directrec playback functions

Operation

Press the  button once while
stopped.

Press the  button once while
stopped.

Hold the  button while stopped
or playing a file.

Hold the  button while stopped
or playing a file.

How to Cancel

Press the  button.
➥ Recorded file will play

again.

Release the  button.

Release the  button.

Playback

functions
Fast Forward
(FF)

Rewind (REW)

Cue (CUE)

Review (REV)

Functions using the [Remote Edit] window

Playing (Playing a Dictation File)
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Save Recording

2,3

File number ........ A serial number automatically assigned by the DSS Player.

The ID that has been set on the Directrec. The default name on the Directrec is
“DR_1000”. The user ID can be modified with DSS Player (�P.25-27).

File names are assigned in the following manner.

 File Name Format

DR_1 0001.dss
Extension

1,4

1 To save the current recording, press
the REC button on the Directrec or
press the  (Stop) button in the
[Remote Edit] to stop recording.

2 Either press the NEW button on
Directrec or click the    icon on the
toolbar in the [Remote Edit] window.
[File Save] window will appear to save the
data.

3 To save the file, either press the NEW
button on the Directrec or click the
[Save] button on the [Remote Edit]
window.
The recorded data will be saved.

4 The Directrec is now available for
recording on a new file,  press the REC
button on the Directrec or press the

 (Record) button in the [Remote
Edit] window to start recording.

3
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Microphone sensitivity is adjustable to meet recording needs.

Microphone Sensitivity

Two recording modes are available with the Directrec. SP (standard
recording) and LP (long-term recording).

Recording Modes

1 Select from the “Sensitivity” box either “Dictation” or
“Conference” in the [Remote Edit] window.
Conference: The high-sensitivity mode suitable for recording the ambient sounds.
Dictation: The low-sensitivity mode suitable for recording dictation.

......................................................................................................................................

Note
• If you want to record clear or noise-free dictation, select Dictation mode and place the

microphone 5 to 10 cm (2 to 4 inches) from the source.

1 Select from the “Quality” box either “SP (mono)” or “LP (mono)”
in the [Remote Edit] window.
SP: Default recording mode.
LP: Can record in a smaller file size with the same recording time as the SP mode.

......................................................................................................................................

Note
• Choose SP mode for recording meetings or lectures with crisp clarity.

1

1
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Index marks can be placed in a file during recording or playback to
provide a quick and easy way of identifying important sections in the file.

Index Marks

Setting an Index Mark

......................................................................................................................................

Notes
• Up to 16 index marks can be set in a file.
• Index marks cannot be set or cleared in a locked file. Please see the Online Help for

further details (�P.8).

1
1 Either press the A  button on

Directrec, or click the  icon on the
toolbar in the [Remote Edit] window
while recording or playing.
Index Mark will now be set.
A  icon will appear on the time axis bar in
the [Remote Edit] window.
The index mark can also be set by selecting
[New Index Mark] in the [Tools] menu.

1

Time axis

Playback slider
Displays the current
position of playback or
recording.
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Index Marks

1

1 Either press FF or REW button on
Directrec twice, or click the 
button on the [Remote Edit] window.
The Playback slider will automatically jump
to the Index Mark( ) position.

Locating an Index Mark

The  icon on the time axis bar in the [Remote Edit] window indicates the
position of  the Index Mark. To jump to a marked position follow this procedure.

1 Click the  icon on the toolbar in the [Remote Edit] window.
Or, select [View All Index Marks...] in the [Tools] menu.
The [View All Index Marks] window will appear.

2 Select the marked position you want to jump to and click [Skip].
Directrec will jump to the selected Index Mark position.

Using the [View All Index Marks] window to jump to the Index Mark

Position of the Index Mark

1
Time axis

2
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1 Locate the index mark you want to clear.

2 Click the icon on the toolbar in the [Remote Edit] window.
Or, select the [Delete Index Mark] in the [Tools] menu.
The index mark is erased.

Clearing an Index Mark

......................................................................................................................................

Note
• Index marks cannot be set or cleared in a locked file. Please see the Online Help for

further details (�P.8).
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1 Click the  icon on the toolbar in the [Remote Edit] window. Or,
select [Directrec Configuration Tool] in the [Tools] menu.
The [Directrec Configuration Tool] dialog box will appear.

2 Select the [Customizing] tab and check the [Enable Beep Sound]
box.

With check: System sound is On.
Without check: System sound is Off.

3 Click [Upload Settings].
The settings are now completed.

System Sounds

The Directrec beeps to alert you to button operations. System sounds
may be turned off.

1

2 3
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Setting Job Data

The files recorded in your PC by Directrec contain Author ID and Work
Type as header information. The details in header information can be
easily changed by using the DSS Player.

Registering Author ID and Work Type ID in DSS Player

Up to the User ID and ten Work Type ID can be registrered in the DSS
Player.

1 Ensure Directrec is not connected.

2 From the DSS Player main window, click the [Download] menu,
then select [Create & Send Job Data...].
The [Create & Send Job Data] window appears.
Enter your Author ID or Work Type ID in the field indicated by the arrow.

3 Click the [Save] button.
Author ID or Work Type ID registration is now completed.

Author ID

Work Type ID

3
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Setting Job Data

Directrec Default User ID to Directrec

The Directrec User ID plays an essential part in the file naming process
of new recordings. The default User ID is “DR_1000”. In order to change
the default user ID, follow the procedure below.

1 Click the  icon on the toolbar in the [Remote Edit] window. Or,
select the [Directrec Configuration Tool] in the [Tools] menu.
The [Directrec Configuration Tool] dialog box will appear.

2 Input your user ID into the [User ID] box and click [Upload Settings].
The input User ID will be transferred to Directrec. The ID can be any
combination of “A” to “Z”, Numeric and/or “_”, and up to a maximum of 16
letters long.

......................................................................................................................................

Note
• Never disconnect the USB access if the indicator light is flashing red. If you do so, the

data may be destroyed.

1

2
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1 Click the    icon on the toolbar in the [Remote Edit] window.
The [Set Job Data] window will appear.

2 Select the desired Author ID from the Author ID list box.

3 Click the [OK] button.
All recordings made by the author during the session will include the set ID
as part of the header information.

2 3

Either the Directrec default Author ID or any DSS Player registered Au-
thor ID (�P.25) can be set in as header information.

1

......................................................................................................................................

Note
• Directrec’s “DR_1000” is the default User ID.

Setting an Author ID
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Setting a Work Type

Any Work Type registered (�P.25) in the DSS Player can be set as
header information.

1 Select the registered Work Type in the Work Type ID setting in the
[Remote Edit] window.
All recordings made with the new Work Type ID will have the new Work Type
as part of the header information.

1

Setting Job Data
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1 Select [Directrec Configuration Tool] in the [Tools] menu in the
[Remote Edit] window. Or, click the  icon on the toolbar.
The [Directrec Configuration Tool] dialog box will appear.

2 Select the function to be assigned to each button and click
[Upload Settings].
The “Successfully upload setting” alert will appear and complete customization.
If the “Failed to upload setting” alert appears, try the setting procedure once
again.

Directrec Button Function Customization

Using [Directrec Configuration Tool], Directrec button functions can be
easily customized to suit individual user needs.

Customizing Directrec Buttons

1

2
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Directrec Button Function Customization

List of customizable buttons

REW

PLAY

FF

NEW

REC

A

B

Default settings

REW

PLAY

FF

NEW

REC

Application (INDEX/DSS Player)

Application (EXIT)

Functions available for settings

REW, PLAY, FF, NEW,

INDEX*1, PRIORITY*2,

INSERT/OVERWRITE*3,

DISABLE*4, Application...*5

*1: [INDEX] button function...To insert an index mark using the [Remote Edit] window.

*2: [PRIORITY] button function...To switch the “Priority” settings in the [Remote Edit] window.

*3: [INSERT/OVERWRITE] button function...To switch the Insert and Overwrite recording modes in the

[Remote Edit] window.

*4: [DISABLE] button function...No function will be assigned.

*5: [Application…] button function...To programme to start a shortcut key for the DSS Player and a

selected application by using the [Directrec APP] tab.

Example: (EXIT) indicates that the shortcut key for the exit command in the [Remote Edit] window is

assigned. Refer to the Online Help for registration.

List of Customizable buttons and Available Functions

Displaying Programmable Buttons

The Directrec Programmable (A,B) buttons can be displayed in the [Re-
mote Edit] window. They are useful as the assigned functions are also
shown.

1 Select and check the [Show Custom Button] box in the [Tools]
menu of the [Remote Edit] window.
The Programmable (A,B) buttons along with their programmed function will
be displayed in the toolbar.

......................................................................................................................................
Note
• The Programmable buttons will not be displayed if the connected device does not include

the same function buttons.

1
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n

1 Click the  icon on the toolbar in the [Remote Edit] window. Or,
select [Directrec Configuration Tool] in the [Tools] menu.
The [Directrec Configuration Tool] dialog box will appear.

2 Select the [Directrec App] tab in the [Directrec Configuration
Tool] dialog box.
The shortcut keys for the [Remote Edit] window programmed to each button
on the Directrec as well as each start-up application are displayed.

Programming Shortcut Keys (Registration)
You can customize the functions of other applications to the Directrec buttons. This
enables you to use the other application software easily while dictating with Directrec.
The selected application shortcut keys can be programmed to Directrec Program-
mable (A,B) buttons by using [Directrec Configuration Tool]. By doing so, the Directrec
buttons can be used to start the applications and command the functions.
The  icon  will be displayed in the task tray as a regular application in [Directrec
Configuration Tool].

Programming [Remote Edit] Function (Default)

The shortcut keys in the DSS Player [Remote Edit] window are
programmed as default.

1

2



32

Directrec Button Function Customization

Directrec programmable (A,B) buttons as well as the [Remote Edit]
window can be used to control and navigate through applications when
they are individually programmed as application shortcuts.
The shortcuts to applications can be saved individually as templates.
As the template can be switched automatically when the application
becomes active, the various applications can be operated by remote
control when required.

1 Click the  icon on the toolbar in the [Remote Edit] window. Or,
select [Directrec Configuration Tool] in the [Tools] menu.
The [Directrec Configuration Tool] dialog box will appear.

2 Click the  icon on the toolbar in [Directrec Configuration Tool].
Or, select [New Template] in the [File] menu.
The [Open] dialog box will appear.

Button

A

B

Shift+FF

Shift+NEW

Shift+A

Shift+PLAY

Shift+REC

Assigned command

Application (To insert an index mark/Running DSS Player)

Application (Exit the Remote Edit window or Main window)

Jump to the index mark

To turn up the volume

To turn down the volume

PRIORITY

Switching Insert/Overwrite Recording

The default programmed shortcut keys are shown below.

Only the programmable (A,B) buttons can be programmed. Program-
ming of the NEW, REW or FF button is not possible. However, the com-
bination with Shift key or Ctrl key of the PC will enable programming.

 Programming shortcut keys to your desired application

2
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3 Browse and Select the application executable and click [Open].
The application shortcut is now set.
For example, if you select Microsoft Word “winword.exe” executable file,
“winword” will be added to the [Directrec Configuration Tool] dialog box.

4 Select the tab added to the [Directrec Configuration Tool] dialog
box and program the shortcut key to Directrec Programmable
(A,B) buttons.
The registered contents will be automatically saved as a template.
Programming to the buttons other than Programmable (A,B) buttons is possible
with the combination with Shift key or Ctrl key of the PC.

Refer to the Online Help (�P.8) for further information on programming
shortcut keys.

A:The [Button] column shows Directrec buttons. Shift+XXX and Ctrl+XXX
indicates the combination of Shift key or Ctrl key on the keyboard and Directrec
buttons.

B:The [Assign] column shows the currently programmed shortcut keys or
the start-up application status.

n

3

A B
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Troubleshooting

Symptom

Unable to use
Directrec controls

No playback tone
heard

Noise heard
during playback

Recording level
too low

Unable to set
index marks

Cannot connect
to PC

Unable to use
Directrec USB
microphone/
speaker.

Probable cause

DSS Player (included in the
package) is not installed.

The [Remote Edit] window in
the DSS Player (included in
the package) is not open.

The sound volume in the
[Remote Edit] window is set to 0.

The sound volume of your
computer is set to 0.

The Directrec was shaken
during recording.

The Directrec was placed
near a cell phone or
fluorescent lamp while
recording or during playback.

The microphone sensitivity is
too low.

The maximum number of
index marks (16) has been
reached.

Sometimes a connection
cannot be made with some
PCs running Windows XP.

USB Audio Device is not
selected in the device settings
of your PC.

Action

Install the DSS Player (�P.6).

Open the [Remote Edit]
window first and then use
Directrec.

Adjust the volume level.

Move the Directrec.

Set the microphone sensitivity
to Conference mode and try
again (�P.20).

Erase unnecessary index
marks (�P.23).

You need to change the PC’s
USB settings. See DSS Player
Online Help for details (�P.8).

Go to the Windows [start]
menu, = [Control Panel] and
then select [Sounds and
Multimedia]. Open the [Audio]
tab and select USB Audio
Device as the setting for
“Sound Playback” and “Sound
Recording”.

For the latest information not included in the user manual, please refer
to the Online Help (�P.8).
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Specifications

Recording format: DSS (Digital Speech Standard)

Input level: –70 dBv

Overall frequency response: 100 to 15,000 Hz

Maximum working output (5 V DC): 300 mW or more (8 Ω speaker)

External dimensions: 157 x 49 x 27 mm (without protrusions)

Weight: 200 g

Cable legth: 2.5 m

Plug shape: USB connector A type

�For customers in the U.S. and Canada
Phone: 1-888-553-4448
E-mail: distec@olympus.com

�For customers in Europe
E-mail : dss.support@olympus-europa.com

Technical Assistance And Support

DR-1000 is part of the Olympus Professional Dictation System. Your dealer
is trained to troubleshoot and fix many common problems that you may
be having with this system. If you encounter problems using your DR-
1000, we recommend that you contact your Olympus Professional Dealer
that sold you the system. If your dealer cannot fix your problem, please
call our technical hotline number or send an E-mail.
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DIRECTREC

DR-1000
Executive Kit

MODE D’EMPLOI

Merci d’avoir porté votre choix sur un Olympus
DIRECTREC.

Lisez ce mode d’emploi pour les informations
concernant l’emploi correct et sûr de l’appareil.

Conservez-le à portée de la main pour toute
référence ultérieure.
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Caractéristiques principales

� Un nouveau système amélioré de microphone réduit les sons parasites
(vent, bruit de machine produit) lors de l’enregistrement, et par
conséquent permet une qualité sonore d’enregistrement supérieure,
jamais atteinte auparavant.

� Un nouveau design et un nouvel emplacement des touches permettent
un contrôle d’une seule main, sans même avoir à vérifier visuellement
la position des touches de fonction. Directrec s’adapte facilement à votre
main, pour un maniement sans effort (�P.4).

� Le Directrec dispose de 2 touches programmables (A,B) (�P.29,30).

� Toutes les fonctions de touche sont facilement personnalisables pour
s’adapter à vos préférences particulières ou à n’importe quel
environnement d’enregistrement (�P.29-33).

� Périphérique audio USB le Directrec, peut être utilisé comme microphone
USB ou haut-parleur USB une fois connecté à un ordinateur. De plus, un
puissant haut-parleur intégré diffuse un son de qualité hi-fi.

� Le Directrec peut être utilisé comme commande à distance pour le DSS
Player Pro (ci-après dénommé DSS Player) non seulement pour
l’enregistrement direct, mais aussi lors de l’édition des fichiers
enregistrés sur un ordinateur.

� Le Directrec peut sauvegarder un fichier d’enregistrement sur un
ordinateur au format DSS (norme vocale numérique).

� Deux modes d’enregistrement, mode SP (Lecture Standard) ou mode
LP (Lecture Longue Durée) (�P.20).

� La qualité du capteur du microphone peut être modifiée pour mieux
s’adapter aux conditions et à l’environnement d’enregistrement (�P.20).

Ce produits possède les caractéristiques suivantes.

• OLYMPUS IMAGING CORPORATION détient les droits du logiciel DSS Player
Pro et des instructions (ce manuel).

• Microsoft et Windows sont des marques déposées ou marque de Microsoft
Corporation.

• Intel et Pentium sont des marques de fabrique déposées par Intel Corporation.

• Les autres noms de produits et de marques indiqués ici peuvent être des
marques de fabrique ou des marques de fabrique déposées de leurs
propriétaires respectifs.
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1 Microphone intégré
2 Voyant d’enregistrement/lecture
3 Touche PLAY (Lire)/

STOP (Arrêt) la fonction
4 Touche NEW (Nouveau)
5 Touche A (Programmable)
6 Touche REW (Retour)
7 Touche REC (Enregistrer)/

STOP (Arrêt) la fonction
8 Touche FF (Avance rapide)
9 Touche souris gauche
0 Dispositif de pointage
! Touche souris droite
@ Haut-parleur intégré
# Touche B (Programmable)
$ Câble USB

Identification des éléments

Comment utiliser le dispositif de
pointage

Manipulez le Directrec avec soin et utilisez
votre pouce pour déplacer le pointeur vers la
direction souhaitée.
Pour cliquer, utilisez la touche droite ou
gauche du dispositif de pointage comme pour
une souris de PC. N’appliquez pas de force
quand vous déplacez ou appuyez sur le
dispositif de pointage.

@

4

3

6

9

0

1

5

8

!
7

#

2

$
Conseil sur le dispositif de pointage

Manipulez le Directrec avec soin et utilisez
votre pouce pour contrôler le pointeur comme
une souris de PC.
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Configuration minimale

Assurez-vous que votre ordinateur dispose de la configuration minimale
détaillée  ci-dessous. Veuillez vous renseigner auprès de votre
administrateur système ou de votre revendeur professionnel Olympus.

IBM PC/AT compatible PC

Microsoft Windows Me/ 2000 Professional/
XP Professional, Edition Familiale

Processeur de classe Intel Pentium II 333 MHz ou
supérieur (Processeur 500 MHz ou supérieur
recommandé)

128 Mo ou plus (256 Mo ou plus recommandé)

50 Mo ou plus

Lecteur de CD-ROM, CD-R, CD-RW, DVD-ROM 2x ou
plus rapide

Creative Labs Sound Blaster 16 ou 100% compatible
Carte son

Microsoft Internet Explorer 4.01 SP2 plus récent

800 x 600 pixels ou plus, 256 couleurs ou plus

un port libre ou plus

PC:

Système
d’exploitation:

CPU:

RAM:

Espace
disque dur:

Lecteur:

Carte son:

Navigateur:

Affichage:

USB port:
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Installation du logiciel DSS Player

1 Insérez le logiciel Olympus DSS Player dans le lecteur de CD-
ROM.
Le programme d’installation démarre automatiquement.
Si le programme d’installation ne démarre pas automatiquement, parcourez
votre lecteur de CD-ROM et exécutez “setup.exe”.

2 La boîte de dialogue permettant de sélectionner la langue à utiliser
pour l’installation apparaît.
Sélectionnez la langue souhaitée.

3 Enregistrez les informations utilisateur.
Enregistrez les informations utilisateur. Entrez votre nom, le nom de votre
société, et le no.d’identification (ID) de licence (le numéro de série).
Le numéro d’identification de licence figure sur la carte d’identification de
licence fournie avec l’enregistreur.
Cliquez sur le bouton [SUIVANT]. Une boîte de dialogue de confirmation
s’affiche; cliquez sur le bouton [OUI].

4 Effectuez l’installation en suivant les instructions qui s’affichent
à l’écran.

Avant de connecter le Directrec à votre ordinateur, vous devez d’abord
installer le logiciel DSS Player.
Assurez-vous de quitter toutes les applications, éjectez la disquette si
vous en utilisez une, et connectez-vous en tant qu’administrateur si vous
utilisez Windows 2000/XP (Professionnel seulement) sur le réseau.
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Désinstaller un logiciel DSS Player

1 Quittez le programme DSS player.

2 Cliquez sur le bouton [démarrer] dans la barre de tâches.

3 Sélectionnez [Ajouter ou Supprimer des programmes] à partir
du [Panneau de configuration].
La liste des applications installées est affichée.

4 Sélectionnez [Olympus DSS Player Pro], puis cliquez sur le bou-
ton [Modifier ou Supprimer].

5 Effectuez la désinstallation en suivant les instructions qui
s’affichent à l’écran.

Pour désinstaller tout composant logiciel du logiciel DSS Player installé
sur votre PC, suivez les étapes ci-dessous.

..............................................................................................................................

Remarque
• La désinstallation n’efface pas les fichiers de dictée enregistrés.
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Utiliser l’aide en ligne

• Cliquez sur le bouton [Démarrer] et sélectionnez [Tous les
programmes], puis [Olympus DSS Player Pro], puis [Aide de
Dictée].

• Lorsque le DSS Player est en marche, sélectionnez le menu
[Contenu] dans le menu [Aide].

• Lorsque le DSS Player est en marche, appuyez sur la touche F1
du clavier.

......................................................................................................................................

Remarque
• Pour plus d’informations concernant l’utilisation du DSS Player et ses fonctions, reportez-

vous à l’aide en ligne. L’aide en ligne est accessible après l’installation du DSS Player.

Pour en savoir plus sur les menus et les opérations, consultez l’aide en ligne.
Pour lancer l’aide en ligne:
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Connexion à votre PC

Assurez-vous d’installer le logiciel DSS Player avant de connecter le
Directrec à l’ordinateur. Cependant, si vous connectez le Directrec avant
ou pendant l’installation du logiciel, l’assistant “Assistant Mise à jour du
matériel” s’affiche. Dans ce cas, annulez l’assistant en cliquant sur le
bouton [Annuler] dans la fenêtre de l’assistant, puis installez ou continuez
l’installation du logiciel DSS Player.

Déconnecter l’enregistreur de votre PC

..............................................................................................................................

Remarques
• Certains ordinateurs et concentrateurs USB peuvent ne pas fournir une alimentation

suffisante et empêcher la connexion du Directrec. Consultez le manuel d’utilisation de
votre ordinateur pour en savoir plus sur le port USB de votre ordinateur ou sur le
concentrateur USB.

• Si vous utilisez un concentrateur USB pour connecter le Directrec, utilisez toujours un
concentrateur USB auto-alimenté (adaptateur secteur).

• Ne débranchez jamais le câble USB tant que les voyants d’enregistrement/lecture
clignotent. Sinon, les données seront détruites.

Connexion à votre PC avec le câble de connexion USB

1 Branchez le câble USB du
Directrec directement dans le
port USB de votre ordinateur
ou dans un concentrateur
USB.

1 Débranchez le câble USB du Directrec du port USB de votre
ordinateur ou du concentrateur USB.
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Commande du DSS Player

Désactivation du démarrage automatique

1 Effectuez un clic droit de la souris sur l’icône   Détection de la
barre des tâches, dans le coin inférieur droit de l’écran, puis
cliquez sur  “Paramètres l’application de démarrage”.

2 Cliquez sur [DSS Player Pro].
La marque de sélection de [DSS Player Pro] disparaît.

Par défaut, la connexion du Directrec à votre ordinateur lancera
automatiquement l’application.

1 Démarrez Windows.

2 Cliquez sur [démarrer], puis sélectionnez [Tous les programmes].
Tout le menu du programme s’affichera.

3 Sélectionnez [Olympus DSS Player Pro], puis cliquez sur le
 [Dictation Module].

Démarrage manuel

......................................................................................................................................

Remarque
• Si vous connectez le Directrec avant d’installer DSS Player, la boîte de dialogue de

l’assistant “Assistant Mise à jour du matériel” s’ouvre. Dans ce cas, cliquez sur [Annuler]
pour quitter l’assistant, puis installez le logiciel DSS Player.

2 3



11

Noms des fenêtres

1 Barre de commande lecture
Boutons de commande pour la lecture et l’arrêt des fichiers de dictée.

2 Visionner l’arbre des dictées
Affiche l’arborescence des dossiers concernant les fichiers au format DSS,
WAVE enregistrés sur le disque dur de votre PC.
Les enregistrement effectués à l’aide du Directrec seront sauvegardés comme

  fichiers dans la Plateau Messages  ( ) dans le Dossier Dictées ( ).

3 Visionner l’arbre des dispositifs
Affiche l’arborescence des dossiers du Directrec.

4 Visionner la liste des dictées
Affiche les fichiers de dictée du dossier sélectionné sous 2 et 3.

Fenêtre Principale (Windows XP)

*Ecran principal est affiché lorsque DSS Player a démarré.

1

4
2

3

Plateau Messages
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Utilisation de la fenêtre Editer à distance

Ouverture de la fenêtre [Editer à distance]

1 Assurez-vous que le Directrec est correctement connecté à votre
ordinateur, puis démarrez DSS Player.
La fenêtre principale DSS Player s’affiche.

2 Dans la fenêtre principale du DSS Player, cliquez sur le menu
[Fichier], puis sélectionnez [Nouveau fichier] ou cliquez sur
l’icône      .
L’écran [Editer à distance] apparaît.

3 Utilisez le Directrec ou la fenêtre [Editer à distance] à votre
convenance.

......................................................................................................................................

Remarques
• Assurez-vous que la fenêtre [Editer à distance] est ouverte lors de l’utilisation du Directrec,

sinon la commande à distance ne fonctionnera pas.
• La fenêtre [Editer à distance] peut aussi s’afficher sans ouvrir le menu principal lors du

lancement de DSS Player (�P.13).

Le Directrec peut être utilisé à la fois comme microphone USB et haut-parleur
USB lorsqu’il est connecté à votre ordinateur. De plus, en ouvrant la fenêtre
[Editer à distance] dans DSS Player, vous pouvez enregistrer directement
(�P.14-16) ou éditer des fichiers à l’aide de la commande à distance.
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Affichage de la fenêtre [Editer à distance] sans ouvrir le menu principal

Vous pouvez configurer votre ordinateur pour que la fenêtre [Editer à
distance] s’ouvre directement au lancement de DSS Player, sans ouvrir
la fenêtre principale.

1 Dans la fenêtre principale du DSS Player, cliquez sur le menu
[Outils], puis sélectionnez [Options...], puis cliquez sur l’onglet
[Direcrec].

2 Cochez la case [Commencez la fenêtre de Editor a distance
automatiquement quand le Dictation Modle est lancé] et cliquez
ensuite sur le bouton [OK].
Les préréglages sont maintenant terminés.
Lorsque les préréglages décochés ont été cochés, l’ordinateur reconnaît la
connexion du périphérique Directrec au lancement de DSS Player et ouvre
la fenêtre [Editer à distance] sans ouvrir la fenêtre principale de l’application
(�P.11).

iter à distance

2



14

Enregistrement direct

1 Dans la fenêtre principale du DSS
Player, cliquez sur le menu [Fichier],
puis sélectionnez [Nouveau fichier...]
ou cliquez sur l’icône      .
L’écran [Editer à distance] apparaît.

2 Appuyez sur la touche REC du Directrec
ou sur la touche  (Enregistrer) dans
la fenêtre [Editer à distance] pour
commencer l’enregistrement.
Le voyant rouge d’enregistrement/lecture sur
le Directrec s’allume. Dirigez le microphone
vers la source sonore.

3 Appuyez sur la touche REC du Directrec
ou sur la touche  (Arrêt) dans la
fenêtre [Editer à distance] pour arrêter
l’enregistrement.
Si vous souhaitez ajouter des enregistrements
supplémentaires au même fichier, Appuyez sur le
bouton de REC sur le Directrec ou appuyez sur la
touche .

Nouvel enregistrement

2,3

Temps d’enregistrement
actuel

Temps d’enregistrement
restant

2 3
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Ecrasement d’enregistrement

Vous pouvez écraser un enregistrement antérieur à partir de n’importe
quel point du fichier. Notez que les enregistrements écrasés seront
effacés.

1 Assurez-vous de vous placer au point
de départ de l’enregistrement à
écraser.

2 Appuyez sur la touche REC  du
Directrec ou sur la touche 
(Enregistrer) dans la fenêtre [Editer à
distance].
Le voyant d’enregistrement/lecture sur le
Directrec s’allume et l ’écrasement
d’enregistrement démarre.

3 Appuyez sur la touche REC  du
Directrec ou sur la touche 
(Arrêt) dans la fenêtre [Editer à
distance] pour arrêter la réécriture.

2,3

......................................................................................................................................

Remarques
• Assurez-vous que la case “Insérer enregistrem” (�P.16) dans la fenêtre [Editer à distance]

n’est pas cochée, sinon l’écrasement d’enregistrement ne s’effectuera pas.
• Vous ne pouvez pas sélectionner un autre mode d’enregistrement (SP, LP) que celui du

fichier d’origine avant d'enregistrer un écrasement.

Ne cochez pas cette case

2 3
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Enregistrement d'insertion

Des informations complémentaires peuvent être insérées dans des
fichiers précédemment enregistrés.

1 Cochez la case ( ) “Insérer enregistrem”
dans la fenêtre [Editer à distance].

2 Assurez-vous de vous placer à la
position exacte dans le fichier où doit
commencer l’enregistrement à insérer.

3 Pendant la lecture du fichier, appuyez sur
la touche REC du Directrec ou sur la touche

 (Enregistrer) dans la fenêtre [Editer
à distance] pour commencer l’insertion
d’un enregistrement supplémentaire.
Le voyant rouge d’enregistrement/lecture sur
le Directrec s’allume.

4 Appuyez sur la touche REC  du
Directrec ou sur la touche 
(Arrêt) dans la fenêtre [Editer à
distance] pour arrêter l’insertion d’un
enregistrement supplémentaire.

3,4

......................................................................................................................................

Remarques
• Assurez-vous que la case “Insérer enregistrem” dans la fenêtre [Editer à distance] est

cochée, sinon l’enregistrement ne s’insèrera pas.
• Vous ne pouvez pas sélectionner un autre mode d’enregistrement (SP, LP) que celui du

fichier d’origine avant d'enregistrer un écrasement.

Enregistrement direct

3 4

1
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1 Appuyez sur la touche PLAY du
Directrec ou sur la touche 
(Lire) dans la fenêtre [Editer à
distance] pour la lecture.
Le voyant vert d’enregistrement/lecture sur
le Directrec s’allume.

2 Réglez le curseur de volume dans la
fenêtre [Editer à distance] sur le
niveau requis.
L’enregistrement sera lu et diffusé à travers
le haut-parleur du Directrec.

3 Appuyez sur la touche PLAY du
Directrec ou sur la touche 
(Arrêt) dans la fenêtre [Editer à
distance] là où vous souhaitez arrêter
la lecture.

1,3

Lecture (Lecture d’un fichier de dictée)

Curseur de lecture
Montre la position de
lecture actuelle

Axe du temps

Temps de lecture
actuel

Temps
d’enregistrement total
du fichier en cours de

lecture

2

3 1
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Fonctions de lecture

Opération

Appuyez une fois sur la touche FF
pendant l’arrêt.

Appuyez une fois sur la touche
REW pendant l’arrêt.

Maintenez la touche FF pressée
pendant l’arrêt ou la lecture d’un fichier.

Maintenez la touche REW pressée
pendant l’arrêt ou la lecture d’un fichier.

Comment annuler

Appuyez sur la touche PLAY.
➥ Le Directrec commence la

lecture à la position définie.

Relâchez la touche FF.

Relâchez la touche REW.

Fonctions de

lecture
Avance rapide
(FF)

Retour (REW)

Repérage
(CUE)

Revue (REV)

• Veuillez consulter notre aide en ligne pour en savoir plus sur les fonctions et les
commandes du Directrec (�P.8).

Diverses fonctions sont disponibles dans le Directrec et la fenêtre [Editer
à distance] pour lire un fichier d’enregistrement.

Fonctions de lecture du Directrec

Opération

Appuyez une fois sur la touche
 pendant l’arrêt.

Appuyez une fois sur la touche
 pendant l’arrêt.

Maintenez la touche  pressée
pendant l’arrêt ou la lecture d’un fichier.

Maintenez la touche  pressée
pendant l’arrêt ou la lecture d’un fichier.

Comment annuler

Appuyez sur la touche .
➥ Le fichier d’enregistrement

sera de nouveau lu.

Relâchez la touche .

Relâchez la touche .

Fonctions de

lecture
Avance rapide
(FF)

Retour (REW)

Repérage
(CUE)

Revue (REV)

Fonctions de la fenêtre [Editer à distance]

Lecture (Lecture d’un fichier de dictée)
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Sauvegarder l’enregistrement

2,3
1 Pour sauvegarder l’enregistrement

actuel, Appuyez sur la touche REC du
Directrec ou sur la touche   (Arrêt)
dans la fenêtre [Editer à distance] pour
arrêter l’enregistrement.

2 Appuyez sur la touche NEW du Directrec
ou cliquez sur  l’icône   dans la barre
d’outils de la fenêtre [Editer à distance].
La fenêtre [Enregistrement du fichier] s’affiche
pour sauvegarder les données.

3 Pour sauvegarder le fichier, appuyez
sur la touche NEW du Directrec ou
cliquez sur le bouton [Enregistrer]
dans la fenêtre [Editer à distance].
Les données enregistrées sont sauvegardées.

4 Le Directrec est maintenant disponible
pour enregistrer dans un nouveau fichier.
Appuyez sur la touche REC du Directrec
ou sur la touche  (Enregistrer) dans
la fenêtre [Editer à distance] pour
commencer l’enregistrement.

Numéro de fichier... Un numéro de série est automatiquement assigné par le Directrec.

Le nom qui a été réglé par le Directrec. Le nom par défaut de le Directrec est
“DR_1000”. Vous pouvez modifier l’ID auteur avec le DSS Player (�P.25-27).

Les noms de fichier sont nommés de la façon suivante.

Format de nom de fichier

DR_1 0001.dss
Extension

1,4

3
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La sensibilité du microphone est ajustable en fonction des besoins
d’enregistrement.

Sensibilité du microphone

Deux modes d’enregistrement sont disponibles avec le Directrec. SP
(enregistrement normal) et LP (enregistrement longue durée).

Modes d’enregistrement

1 Sélectionnez dans le champ “Sensibilité” soit “Dictée” ou
“Conférence” dans la fenêtre [Editer à distance].
Conférence: Mode haute sensibilité adapté à l’enregistrement des ambiances sonores.
Dictée: Mode basse sensibilité adapté à l’enregistrement de dictée.

......................................................................................................................................

Remarque
• Si vous souhaitez enregistrer une dictée claire et intelligible, passez au mode Dictée et

rapprochez (5 ou 10 cm) le microphone interne du haut-parleur.

1 Sélectionnez dans le champ “Qualité” soit “SP (mono)” ou “LP
(mono)” dans la fenêtre [Editer à distance].
SP: Mode d’enregistrement par défaut.
LP: Peut enregistrer dans un fichier de plus petite taille le même
      enregistrement qu’en mode SP.

......................................................................................................................................

Remarque
• Choisissez le mode SP pour enregistrer des réunions ou conférences avec une grande netteté.

1

1
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Des marques d’index peuvent être placées dans un fichier pendant
l’enregistrement ou la lecture afin de fournir un moyen simple et rapide
d’identifier les sections importantes du fichier.

Marques index

Réglage d’une marque index

......................................................................................................................................

Remarques
• Jusqu’à 16 marques index peuvent être posées dans un fichier.
• Des marques index ne peuvent pas être posées ou effacées dans un fichier verrouillé.

Veuillez consulter l’aide en ligne pour en savoir plus (�P.8).

1
1 Appuyez sur la touche A du Directrec

ou bien cliquez sur l’icône  dans la
barre d’outils de la fenêtre [Editer à
distance].
La marque d’index est maintenant définie.
Une icône s’affiche sur la barre de l’axe
temporel dans la fenêtre [Editer à distance].
La marque d’index peut aussi être définie en
sélectionnant [Nouvelle marque d’index] dans
le menu [Outils].

Axe du
 temps

Curseur de lecture
Affiche la position actuelle
de lecture ou
d’enregistrement.

1
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Marques index

1

1 Appuyez deux fois sur la touche FF
ou REW du Directrec ou bien cliquez
sur le bouton  dans la fenêtre
[Editer à distance].
Le curseur de lecture saute automatiquement
à la position de la marque d’index ( ).

Repérage d’une marque index

L’icône  sur la barre de l’axe temporel dans la fenêtre [Editer à dis-
tance] indique la position de la marque d’index. Pour sauter à une posi-
tion marquée, suivez cette procédure.

1 Cliquez sur l’icône        dans la barre d’outils de la fenêtre [Editer
à distance]. Ou sélectionnez [Afficher toute les marques
d’index...] dans le menu [Outils].
La fenêtre [Liste des marques d’index] s’affiche.

2 Sélectionnez la position marquée sur laquelle vous souhaitez
sauter et cliquez sur [Sauter].
Le Directrec saute à la position de la marque d’index.

Utilisation de la fenêtre [Liste des marques d’index] pour sauter à la marque d’index

Position de la marque d’index

Axe du
 temps

1

2
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1 Repérez la marque index que vous souhaitez effacer.

2 Cliquez sur l’icône dans la barre d’outils de la fenêtre [Editer
à distance]. Ou sélectionnez [Effacer une marque d’index] dans
le menu [Outils].
La marque index est effacée.

Effacement d’une marque index

......................................................................................................................................

Remarque
• Des marques index ne peuvent pas être posées ou effacées dans un fichier verrouillé.

Veuillez consulter l’aide en ligne pour en savoir plus (�P.8).
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1 Cliquez sur l’icône  dans la barre d’outils de la fenêtre [Editer
à distance]. Ou sélectionnez [Directrec Configuration Tool] dans
le menu [Outils].
La boîte de dialogue [Directrec Configuration Tool] s’affiche.

2 Sélectionnez l’onglet [Personnalisation] et cochez la case
[Activer le bip].

Cochée: Les avertissements sonores sont activés.
Décochée: Les avertissements sonores sont désactivés

3 Cliquez sur [Exporter les réglages].
Les réglages sont maintenant terminés.

Système son

Le Directrec émet des bips pour vous signaler le fonctionnement des
touches. Les avertissements sonores peuvent être désactivés.

1

2 3
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Réglage de Job Data

Les fichiers enregistrés dans votre ordinateur par le Directrec contiennent
un ID auteur et un ID de type de travail comme en-tête d’information.
Les détails contenus dans l’en-tête d’information peuvent être facilement
modifiés à l’aide du DSS Player.

Enregistrement d’un ID auteur et d’un ID de type
de travail dans DSS Player

Jusqu’à dix ID utilisateur et ID de type de travail peuvent être enregistrés
dans DSS Player.

1 Assurez-vous que le Directrec n’est pas connecté.

2 Dans la fenêtre principale du DSS Player, cliquez sur le menu
[Télécharger] , puis sélectionnez [Créer et envoyer les données
du travail...].
L’écran [Créer et envoyer les données du travail] apparaît.
Entrez votre ID auteur ou ID de type de travail dans le champ indiqué par la
flèche.

3 Cliquez sur [Enregistrer].
L’enregistrement de l’ID auteur ou de l’ID de type de travail est maintenant terminé.

3

ID auteur

Type de travail
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Réglage de Job Data

ID utilisateur du Directrec par défaut

L’ID utilisateur du Directrec joue un rôle essentiel dans le processus
pour nommer les nouveaux fichiers d’enregistrements. L’ID utilisateur
par défaut est “DR_1000”. Pour modifier l’ID utilisateur par défaut, suivez
la procédure ci-dessous.

1 Cliquez sur l’icône  dans la barre d’outils de la fenêtre [Editer
à distance]. Ou sélectionnez [Directrec Configuration Tool] dans
le menu [Outils].
La boîte de dialogue [Directrec Configuration Tool] s’affiche.

2 Entrez votre ID utilisateur dans le champ [Identité de I’auteur] et cliquez
sur [Exporter les réglages].
L’ID utilisateur entré est transféré dans le Directrec. L’ID peut être n’importe
quelle combinaison de  “A” à “Z”, de nombres et/ou de “_”, pour une longueur
maximale de 16 caractères.

1

......................................................................................................................................

Remarque
• Ne déconnectez jamais l’accès USB si le voyant clignote en rouge. Sinon, les données

pourraient se perdre.

2
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Réglage d’un ID auteur

1 Cliquez sur l’icône  dans la barre d’outils de la fenêtre [Editer à
distance] .
La fenêtre [Régler les données du travail] s’affiche.

2 Sélectionnez l’ID auteur souhaité dans la liste déroulante ID auteur.

3 Cliquez sur [OK].
Tous les enregistrements faits par l’auteur pendant la session verront leur ID
faire partie de l’information de l’en-tête.

L’ID auteur par défaut du Directrec ou tout ID auteur enregistré dans
DSS Player (�P.25) peut être défini comme information d’en-tête.

1

......................................................................................................................................

Remarque
• “DR_1000” du Directrec est l’ID utilisateur par défaut.

2 3
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Réglage d’un type de travail

Tout type de travail enregistré dans DSS Player (�P.25) peut être défini
comme information d’en-tête.

1 Sélectionnez le type de travail enregistré dans le paramètre ID de type
de travail dans la fenêtre [Editer à distance].
Tous les enregistrements effectués avec le nouveau ID de type de travail
verront celui-ci faire partie de l’information de l’en-tête.

1

Réglage de Job Data
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1 Sélectionnez [Directrec Configuration Tool] dans le menu [Outils]
de la fenêtre [Editer à distance]. Ou cliquez sur l’icône   dans
la barre d’outils.
La boîte de dialogue [Directrec Configuration Tool] s’affiche.

2 Sélectionnez la fonction à personnaliser pour chaque touche et
cliquez sur [Exporter les réglages].
L’alerte “Réglages exportés avec succès” s’affichera et terminera la
personnalisation.
Si l’alerte “Echec de l’exportation des réglages” s’affiche, renouvelez la
procédure de configuration.

Personnalisation des fonctions
des touches Directrec

A l’aide de [Directrec Configuration Tool], les fonctions des touches du
Directrec peuvent être facilement personnalisées pour s’adapter aux
besoins de l’utilisateur.

Personnalisation des touches du Directrec

1

2
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Personnalisation des fonctions des touches Directrec

Liste des touches personnalisables

REW

PLAY

FF

NEW

REC

A

B

Réglages par défaut

REW

PLAY

FF

NEW

REC

Application (INDEX/DSS Player)

Application (EXIT)

Fonctions disponibles pour la
personnalisation

REW, PLAY, FF, NEW,

INDEX*1, PRIORITY*2,

INSERT/OVERWRITE*3,

DISABLE*4, Application...*5

*1: [INDEX] fonction de touche...Pour insérer une marque d’index à l’aide de la fenêtre [Editer à distance].
*2: [PRIORITY] fonction de touche...Pour modifier le paramètre “Prioritè” dans la fenêtre [Editer à distance].

*3: [INSERT/OVERWRITE] fonction de touche...Pour modifier les modes d’enregistrement Insertion et
Ecrasement dans la fenêtre [Editer à distance].

*4: [DISABLE] touche de fonction...Aucune fonction ne sera affectée.

*5: [Application...] touche de fonction...Pour programmer une touche de raccourci pour lancer DSS
Player et une application sélectionnée à l’aide de l’onglet [Directrec APP].
Exemple: (EXIT) indique que la touche de raccourci pour la commande de sortie dans la fenêtre
[Editer à distance] est affectée. Consultez l’aide en ligne pour l’enregistrement.

Liste des touches personnalisables et des fonctions disponibles

Affichage des touches programmables

Les touches programmables (A,B) du Directrec peuvent être affichées dans la fenêtre
[Editer à distance]. Elles sont utiles car les fonctions programmées sont aussi affichées.

1 Sélectionnez et cochez la case [Afficher bouton Personnaliser]
dans le menu [Outils] de la fenêtre [Editer à distance].
Les touches programmables (A,B) avec leurs fonctions programmées
s’afficheront dans la barre d’outils.

......................................................................................................................................
Remarque
• Les touches programmables ne s’afficheront pas si le périphérique connecté ne possède

pas les mêmes touches de fonction.

1
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ches Directrec

1 Cliquez sur l’icône  dans la barre d’outils de la fenêtre [Editer
à distance]. Ou sélectionnez [Directrec Configuration Tool] dans
le menu [Outils].
La boîte de dialogue [Directrec Configuration Tool] s’affiche.

2 Sélectionnez l’onglet [Directrec App] dans la boîte de dialogue
[Directrec Configuration Tool].
Les touches de raccourci pour la fenêtre [Editer a distance] et programmées
dans chaque touche du Directrec, ainsi que chaque application de lancement,
sont affichées.

Programmation des touches de raccourci (enregistrement)
Les touches de raccourci de l’application sélectionnée peuvent être
programmées dans les touches programmables (A,B) du Directrec à l’aide
de [Directrec Configuration Tool]. Dans ce cas, les touches du Directrec
peuvent être utilisées pour lancer des applications et exécuter des fonctions.
L’icône  s’affichera dans la barre de tâches comme une application
normale dans [Directrec Configuration Tool].

Programmation de la fonction [Editer à distance] (défaut)

Les touches de raccourci dans la fenêtre [Editer à distance] du DSS
Player sont programmées par défaut.

1

2
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Personnalisation des fonctions des touches Directrec

Les touches programmables (A,B) du Directrec, ainsi que la fenêtre [Editer à dis-
tance], peuvent être utilisées pour contrôler et naviguer à travers des applications
lorsqu’elles sont individuellement programmées comme raccourcis d’application.
Les raccourcis d’application peuvent être sauvegardés individuellement comme modèles.
Puisque le modèle peut être activé automatiquement lorsque l’application est
lancée, les différentes applications peuvent être pilotées par la commande à
distance si nécessaire.

1 Cliquez sur l’icône  dans la barre d’outils de la fenêtre [Editer
à distance]. Ou sélectionnez [Directrec Configuration Tool] dans
le menu [Outils].
La boîte de dialogue [Directrec Configuration Tool] s’affiche.

2 Cliquez sur l’icône  dans la barre d’outils de la fenêtre
[Directrec Configuration Tool]. Ou sélectionnez [Nouveau
modèle] dans le menu [Fichier].
La boîte de dialogue [Ouvrir] s’affiche.

Touche

A

B

Shift+FF

Shift+NEW

Shift+A

Shift+PLAY

Shift+REC

Commande affectée

Application (Pour insérer une marque d'index/Commande du DSS Player)

Application (Quitte la fenêtre Editer à distance ou Fenêtre principale)

Saute à la marque d’index

Pour monter le volume

Pour baisser le volume

Prioritè

Bascule l’enregistrement d’insertion/écrasement

Les touches de raccourci programmées par défaut sont indiquées ci-dessous.

Seules les touches (A,B) peuvent être programmées. La programmation des
touches NEW, REW ou FF est impossible. Cependant, la combinaison avec
les touches Majuscule ou Ctrl de l’ordinateur permettra la programmation.

 Programmation des touches de raccourci pour votre application souhaitée

2
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3 Parcourez le disque dur, sélectionnez l’exécutable de
l’application et cliquez sur [Ouvrir].
Le raccourci de l’application est maintenant défini.
Par exemple, si vous sélectionnez le fichier exécutable de Microsoft Word
“winword.exe”, “WinWord” sera ajouté à la boîte de dialogue [Directrec
Configuration Tool].

4 Sélectionnez l’onglet ajouté à la boîte de dialogue [Directrec
Configuration Tool] et programmez la touche de raccourci dans
les touches programmables (A,B) du Directrec.
Le contenu enregistré sera automatiquement sauvegardé comme modèle. La
programmation dans des touches autres que les touches programmables (A,B)
est possible avec la combinaison des touches Shift et Ctrl de l’ordinateur.

Consultez l’aide en ligne (�P.8) pour en savoir plus sur la programmation
des touches de raccourci.

A:La colonne [Bouton] indique les touches du Directrec. Shift+XXX et Ctrl+XXX indique
la combinaison entre les touches Shift et Ctrl du clavier et les touches du Directrec.

B:La colonne [Attribuer] indique les touches de raccourci actuellement programmées
ou l’état de l’application de lancement.

ches Directrec

3

A B
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Dépannage

Pour des informations complémentaires non inclus dans le manuel
d’utilisation merci de vous référer à l'aide en ligne (�P.8).

Symptôme

Impossible
d’utiliser les
commandes du
Directrec

Pas de tonalité
de lecture

Bruit audible
pendant la
lecture

Niveau
d’enregistrement
faible

Pose de marques
index impossible

Impossible de se
connecter au PC

Impossible
d’utiliser le
microphone/haut-
parleur USB du
Directrec.

Cause probable

DSS Player (inclus dans le
lot) n’est pas installé.

La fenêtre [Editer à distance]
dans DSS Player (inclus dans
le lot) n’est pas ouverte.

Le volume sonore dans la
fenêtre [Editer à distance] est
réglé sur 0.

Le volume sonore de votre
ordinateur est réglé sur 0.

Le Directrec a été secoué
pendant l’enregistrement.

Le Directrec a été placé à
proximité d’un téléphone
cellulaire ou d’une lampe
fluorescente pendant
l’enregistrement ou la lecture.

La sensibilité du microphone
est trop faible.

Le nombre max. de marques
index (16) a été atteint.

Les PC fonctionnant sous
Windows XP ne permettent
pas tous la connexion.

Le périphérique audio USB
n’est pas sélectionné dans les
paramètres audio de votre
ordinateur.

Mesure

Installez DSS Player (�P.6).

Ouvrez d’abord la fenêtre
[Editer à distance] et utilisez
ensuite le Directrec.

Ajustez la volume.

Déplacez le Directrec.

Réglez le en mode Conference
et essayez à nouveau (�P.20).

Effacez les marques inutiles
(�P.23).

Vous devrez modifier les
réglages USB du PC. Pour les
détails, voyez l’aide en ligne du
DSS Player (�P.8).

Allez dans le menu [start], =
[Panneau de configuration] et
sélectionnez ensuite [Son et
Multimédia]. Ouvrez l’onglet
[Audio] et sélectionnez
Périphérique audio USB dans
les paramètres “Lecture audio”
et “Enregistrement audio”.
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Format d’enregistrement: DSS (Digital Speech Standard)

Niveau d’entrée: –70 dBv

Réponse en fréquence générale: 100 à 15.000 Hz

Puissance de travail max. (5 V c.c.): 300 mW ou plus (haut-parleur 8 Ω)

Dimensions extérieures: 157 x 49 x 27 mm (sans protubérance)

Poids: 200 g

Longueur de câble: 2,5 m

Type de prise: connecteur USB de type A

Spécifications

Assistance technique et soutien

�Pour les clients résidant aux Etats-Unis et au Canada
Téléphone: 1-888-553-4448
Courriel: distec@olympus.com

�Pour les clients résidant en Europe
Courriel : dss.support@olympus-europa.com

Le DR-1000 fait partie du système de dictée professionnel Olympus. Votre
revendeur est formé au dépistage des pannes et pourra régler beaucoup
des problèmes ordinaires que vous pourriez avoir avec ce système. En
cas de problème à l’utilisation du DR-1000, nous vous recommandons
de contacter le revendeur Olympus qui vous a vendu le système. Si votre
revendeur ne peut pas résoudre le problème, appelez notre numéro de
téléphone de ligne directe technique ou envoyez-nous un message par
courrier électronique.
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Vielen Dank für das Vertrauen in Olympus-
Produkte, das Sie uns mit dem Kauf des Olympus

DIRECTREC erwiesen haben.
Machen Sie sich bitte gründlich mit dem Inhalt

dieser Bedienungsanleitung vertraut, damit stets
ein einwandfreier und sicherer Betrieb des

Produkts gewährleistet ist.
Bewahren Sie außerdem die

Bedienungsanleitung stets griffbereit für
späteres Nachschlagen auf.
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Hauptmerkmale

� Das neue und verbesserte Mikrophonsystem reduziert Fremdgeräusche
wie Wind oder Maschinenlärm, die während der Aufnahme entstehen. Somit
sind qualitativ hochwertigere Tonaufnahmen möglich, als jemals zuvor.

� Das neue Design und die neue Platzierung der Tasten ermöglichen eine
Einhandbedienung, ohne dass es nötig ist, die Anbringung der
Bedienungstasten mit dem Auge zu überprüfen. Der Directrec liegt sehr
gut in der Hand und bietet eine mühelose Bedienung zusammen mit
einem großartigen Diktiererlebnis (�S.4).

� Der Directrec verfügt über 2 progammierbare (A,B) Tasten (�S.29,30).

� Alle Tastenfunktionen wurden angepasst, um einer bestimmten Präferenz
oder jedem Aufnahmeumfeld gerecht zu werden (�S.29-33).

� Das USB Audio Gerät der Directrec, kann als USB-Mikrofon oder USB-
Lautsprecher verwendet werden, wenn das Gerät an einen PC
angeschlossen wird. Außerdem bietet ein leistungsstarker, eingebauter
Lautsprecher eine akustische Hi-Fi-Wiedergabe.

� Der Directrec kann als Fernbedienung für den DSS Player Pro (im Folgenden
DSS Player genannt) verwendet werden - nicht nur für die direkte Aufnahme,
sonder auch zur Bearbeitung von Dateien auf einem PC.

� Der Directrec kann eine Aufnahme als Datei auf einem PC im DSS Format
(Digital Speech Standard) speichern.

� Zwei Aufnahmemodi, SP (Standardwiedergabe) Modus oder LP (Langzeit-
Wiedergabe) Modus (�S.20).

� Die Qualität des Mikrofonsensors kann für eine bessere Anpassung an
die Aufnahmebedingungen und an das Aufnahmeumfeld abgeändert
werden (�S.20).

Dieses Produkt ist mit folgenden Funktionen ausgestattet.

• Die OLYMPUS IMAGING CORPORATION besitzt die Urheberrechte für die
DSS Player Pro-Software und die Bedienungsanleitung (diese Anleitung).

• Microsoft und Windows sind eingetragene Warenzeichen von Microsoft
Corporation.

• Intel und Pentium sind eingetragene Warenzeichen von Intel Corporation.

• Andere hier genannte Produkt- und Markennamen sind u.U. Warenzeichen
oder eingetragene Warenzeichen der jeweiligen Urheberrechtsinhaber.
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1 Integriertes Mikrofon
2 Aufnahme/Wiedergabe-

Kontrollleuchte
3 PLAY (Wiedergabe)-Taste/

STOP (Stopp)-Funktion
4 NEW-Taste (Neue)
5 A-Taste (Programmierbar)
6 REW-Taste (Rücklauf)
7 REC-Taste (Aufnahme)/

STOP (Stopp)-Funktion
8 FF-Taste (Schnellvorlauf)
9 Linke Maustaste
0 Mausfeld
! Rechte Maustaste
@ Integrierter Lautsprecher
# B-Taste (Programmierbar)
$ USB-Kabel

Bezeichnung der Teile

Verwendung des Mausfelds

Den Directrec behutsam halten und die
Zeigereinrichtung mit dem Daumen in die
gewünschte Richtung bewegen. Verwenden Sie
zum Klicken die rechte oder linke Taste des
Zeigegeräts – so wie bei einer Computermaus.
Betätigen oder bewegen Sie das Zeigegerät
sachte.

@

4

3

6

9

0

1

5

8

!
7

#

2

$

Tipps zum Mausfeld

Den Directrec behutsam halten und die
Zeigereinrichtung mit dem Daumen wie eine
Computermaus steuern.
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Minimale Anforderungen

Vergewissern Sie sich, dass Ihr Computer die unten angegebenen
Systemanforderungen erfüllt. Prüfen Sie dies mit Ihrem System Admin-
istrator oder Ihrem Olympus-Fachhändler.

IBM-PC/AT-kompatibler PC

Microsoft Windows Me/ 2000 Professional/ XP
Professional, Home Edition

Intel-Mikroprozessor Pentium II 333 MHz oder besser
(Verwenden Sie bitte einen Bereich von 500 MHz oder
besser)

128 MB oder mehr (256 MB oder mehr wird empfohlen)

50 MB oder mehr

2x oder schneller CD-ROM, CD-R, CD-RW, DVD-ROM
Laufwerk

Creative Labs Sound Blaster 16 oder 100%
kompatible Soundkarte

Microsoft Internet Explorer 4.01 SP2 oder später

Mindestens 800 x 600 Pixel, mindestens 256 Farben

Ein oder mehr freier Anschlüsse

PC:

Betriebs-
system:

CPU:

RAM:

Festplatten-
speicher:

Laufwerk:

Soundkarte:

Browser:

Anzeige:

USB-
Anschluss:
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Installieren der DSS Player-Software

1 Legen Sie die DSS Player-Software CD von Olympus in das CD-
ROM-Laufwerk ein.
Das Installationsprogramm startet automatisch.
Falls das Installationsprogramm nicht automatisch startet, durchsuchen Sie
Ihr CD-ROM Laufwerk und führen Sie „setup.exe“ durch.

2 Das Dialogfenster zur Auswahl der Installationssprache erscheint.
Wählen Sie die gewünschte Sprache aus.

3 Registrieren Sie die Benutzerdaten.
Geben Sie hierzu Ihren Namen, den Namen Ihrer Firma und Ihre Lizenznummer
(Seriennummer) ein.
Die Lizenz ID-Nummer ist auf der Lizenz ID-Karte aufgedruckt, die zum
Lieferumfang des Recorders gehört.
Klicken Sie auf das Feld [Weiter]. Ein Bestätigungs-Dialogfenster erscheint,
klicken Sie auf [Ja].

4 Fahren Sie mit der Installation entsprechend den Anweisungen
auf dem Bildschirm fort.

Bevor Sie Ihren Directrec an Ihren PC anschließen, müssen Sie zuvor
die DSS Player-Software.
Achten Sie darauf, daß Sie alle laufenden Anwendungen beenden.
Entfernen Sie die Diskette aus dem Laufwerk, falls Sie eine benutzen.
Wenn Sie Windows2000/XP (nur Professional) im Netzwerk betreiben,
müssen Sie sich als Administrator anmelden.
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Deinstallieren der DSS Player-Software

1 Beenden Sie das DSS Player Programm.

2 Klicken Sie auf [Start] in der Task-Leiste.

3 Wählen Sie [Programm Hinzufügen/Entfernen] aus der
[Systemsteuerung].
Eine Liste der installierten Anwendungen wird angezeigt.

4 Wählen Sie [Olympus DSS Player Pro], und klicken Sie auf
[Ändern/Entfernen].

5 Fahren Sie mit der Installation entsprechend den Anweisungen
auf dem Bildschirm fort.

Folgen Sie den nachstehenden Schritten, wenn Sie eine der
Softwarekomponenten der auf Ihrem PC installierten DSS Player Soft-
ware zu deinstallieren.

..............................................................................................................................

Hinweis
• Bei Deinstallation werden keine gespeicherten Diktatdateien gelöscht.
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Näheres zum Gebrauch und den Funktionen des DSS Players finden
Sie in der Online-Hilfe.
Zum Starten der Online-Hilfe:

Verwenden der Online-Hilfe

• Klicken Sie auf [Start], wählen Sie dann [Alle Programme],
[Olympus DSS Player Pro], [Diktat-Hilfe].

• Während der DSS Player läuft, wählen Sie das [Hilfe]-Menü,
[Inhalt].

• Während der DSS Player läuft, drücken Sie F1 auf der Tastatur.

......................................................................................................................................

Hinweis
• Für Informationen über den Gebrauch und den Funktionen des DSS Players beziehen

Sie sich bitte auf die Online Hilfe. Sie können die Online-Hilfe nach der Installation des
DSS Players verwenden.
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Anschluss des Directrec an Ihren PC

Vor dem Anschließen des Directrec an den PC sollte die DSS Player-
Software installiert sein. Falls Sie jedoch den Directrec vor oder während
der Installation der Software anschließen, erscheint der
„Hardwareupdate-Assistent“. Beenden Sie den Assistenten, indem Sie
die Taste [Abbrechen] im Assistenten-Bildschirm drücken, und
installieren Sie dann den DSS Player oder fahren Sie mit seiner Instal-
lation fort.

Trennen der Verbindung zum PC

..............................................................................................................................

Hinweise
• Manche PCs und USB-Hubs liefern u.U. nicht genug Leistung, sodass der Directrec nicht

anspricht. Informationen zum USB-Anschluss oder USB-Hub Ihres PCs entnehmen Sie
bitte dem Benutzerhandbuch für Ihren PC.

• Wenn Sie einen USB-Hub verwenden, um den Directrec anzuschließen, verwenden Sie
stets einen USB-Hub mit seperater Stromversorgung (Netzadapter).

• Bei blinkender  Aufnahme/Wiedergabe-Kontrollleuchte darf das USB nicht abgezogen
werden. Andernfalls werden die Daten zerstört.

Anschluss an den PC über USB-Kabel

1 Schließen Sie das USB-Kabel
des Directrec direkt an den
USB-Port oder USB-Hub Ihres
PCs an.

1 Ziehen Sie das USB-Kabel des Directrec aus dem USB-Port oder
USB-Hub Ihres PCs.
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Bedienung des DSS Players

Deaktivieren des automatischen Starts

1 Klicken Sie mit der rechten Maustaste auf das Device Detector
 Symbol im System Tray rechts unten im Bildschirm, und

klicken Sie auf „Auswahl Autostart-Anwendung“.

2 Klicken Sie [DSS Player Pro].
Die Kontrollmarkierung bei [DSS Player Pro] verschwindet.

Durch werkseitige Einstellung wird beim Anschluss des Directrec an
Ihren PC die Anwendung automatisch gestartet.

1 Starten Sie Windows.

2 Klicken Sie in Windows auf [Start], zeigen Sie auf [Alle
Programme].
Das Menü Alle Programme wird angezeigt.

3 Wählen Sie [Olympus DSS Player Pro], und klicken Sie auf [Dic-
tation Module].

Manueller Start

......................................................................................................................................

Hinweis
• Wenn Sie den Directrec vor der Installation des DSS Players anschließen, öffnet sich das

Dialogfenster „Hardwareupdate-Assistent“. Klicken Sie in diesem Fall auf [Abbrechen], um den
Hardware-Assistenten zu beenden, und installieren Sie dann die mitgelieferte DSS Player-Software.

2 3
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Fensterbezeichnungen

1 Wiedergabekontrolleiste
Steuerungstasten mit Wiedergabe- und Stoppfunktionen für Diktatdateien.

2 Diktat-Baumansicht
Zeigt die Verzeichnisstruktur der Dateien im Format DSS, WAVE bzw.
Aufnahmen, die mit dem Directrec erstellt wurden, werden als Datei in der
Nachrichten-Ablage ( ) im Diktat-Ordner ( ) gespeichert.

3 Geräte-Baumansicht
Zeigt die Verzeichnisstruktur des Directrec an.

4 Diktat-Listenansicht
Zeigt die Diktatdateien im Ordner an, die bei 2 und 3 ausgewählt wurden.

Hauptfenster (Windows XP)

1

4
2

3

Nachrichten-Ablage

* Die Hauptseite wird angezeigt, wenn der DSS Player
gestartet ist.
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Gebrauch des Fernbearbeitungsfensters

Öffnen des Fensters [Fernbearbeitung]

1 Stellen Sie sicher, dass der Directrec ordnungsgemäß an Ihren
PC angeschlossen ist und starten Sie den DSS Player.
Das Hauptfenster des DSS Players erscheint.

2 Wählen Sie aus dem DSS Player Hauptfenster das [Datei] Menü,
wählen Sie dann [Neue Datei...] oder klicken Sie auf das
      Symbol.
Das Fenster [Fernbearbeitung] erscheint.

3 Verwenden Sie für den gewünschten Bedienungsschritt den
Directrec oder das Fenster [Fernbearbeitung].

......................................................................................................................................

Hinweise
• Vergewissern Sie sich, dass das Fenster [Fernbearbeitung] geöffnet ist, wenn Sie den

Directrec verwenden. Andernfalls funktioniert die Fernbedienung nicht.
• Das Fenster  [Fernbearbeitung] kann auch geöffnet werden, ohne das Hauptmenü zu

öffnen, wenn der DSS Player (�S.13) gestartet wird.

Der Directrec kann sowohl als USB-Mikrofon als auch als ein USB-
Lautsprecher verwendet werden, wenn er an Ihren PC angeschlossen
wurde. Außerdem können Sie, wenn Sie das Fenster [Fernbearbeitung]
im DSS Player öffnen, direktes Aufnehmen (�S.14-16) oder
Dateibearbeitungen mittels der Fernbedienung ausführen.
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Anzeige des Fensters [Fernbearbeitung], ohne das Hauptmenü zu öffnen

Sie können Ihren PC so einstellen, dass Sie das Fenster
[Fernbearbeitung] direkt öffnen können, ohne in das Hauptfenster zu
gehen, wenn Sie den DSS Player starten.

1 Wählen Sie aus dem DSS Player Hauptfenster das [Extras] Menü,
wählen Sie dann [Optionen...], und klicken Sie auf Register
[Directrec].

2 Setzen Sie bei [Beginnen Sie Fernbearbeitung Fenster
automatisch, wenn Dicttation Module ausgestoßen wird] und
klicken Sie dann auf [OK].
Die Voreinstellungen sind nun abgeschlossen.
Wenn die unmarkierten Voreinstellungen markiert werden, erkennt der
Computer die Directrec-Geräte-Verbindung als den Start eines DSS Players
und öffnet deshalb das Fenster [Fernbearbeitung], ohne das
Hauptanwendungsfenster zu öffnen (�S.11).

tungsfensters

2
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Direktes Aufnehmen

1 Wählen Sie aus dem DSS Player
Hauptfenster das [Datei] Menü,
wählen Sie dann [Neue Datei...] oder
klicken Sie auf das  Symbol.
Das Fenster [Fernbearbeitung] erscheint.

2 Drücken Sie die REC-Taste des
Directrec oder drücken Sie die

(Aufnahme)-Taste im Fenster
[Fernbearbeitung], um mit der
Aufnahme zu beginnen.
Die rote Aufnahme/Wiedergabe-Kontrollleuchte
leuchtet am Directrec auf. Richten Sie das Mikrofon
auf die Klangquelle.

3 Drücken Sie die REC-Taste des
Directrec oder drücken Sie die

(Stopp)-Taste im Fenster
[Fernbearbeitung], um die Aufnahme
zu stoppen.
Sollen zusätzliche Aufzeichnungen an die
gleiche Datei angehängt werden, Drücken Sie
die REC-Taste auf dem Directrec oder
betätigen Sie die  -Taste.

Neuaufnahme

2,3

Aktuelle
Aufnahmezeit Restliche Aufnahmezeit

2 3
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Überschreiben von Aufnahmen

Sie können den Inhalt einer früheren Aufzeichnung von jedem Punkt
auf der Datei aus überschreiben. Beachten Sie, dass die überschriebene
Aufnahmen gelöscht wird.

1 Vergewissern Sie sich, dass Sie am
Anfangspunkt der zu
überschreibenden Aufnahme sind.

2 Drücken Sie die REC-Taste des Directrec
oder drücken Sie die  (Aufnahme)-
Taste im Fenster [Fernbearbeitung].
Die Aufnahme/Wiedergabe-Kontrollleuchte
auf dem Directrec leuchtet auf und es wird
mit dem Überschreiben von Aufnahmen
begonnen.

3 Drücken Sie die REC-Taste des Directrec
oder drücken Sie die  (Stopp)-Taste
im Fenster [Fernbearbeitung], um das
Überschreiben zu beenden.

2,3

......................................................................................................................................

Hinweise
• Stellen Sie sicher, dass das Kästchen „Aufnahme einfügen“ (�S.16) im Fenster

[Fernbearbeitung] nicht markiert ist, da sonst die das Überschreiben von Aufnahmen
nicht weitergeführt wird.

• Beim Überschreiben von Daten müssen Sie unbedingt die Aufnahmeart (SP, LP) für die
ursprüngliche Datei beibehalten.

Hier nicht markieren

2 3
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Einfügen von Anfnahmen

Das Einfügen einer zusätzlichen Aufnahme in bereits aufgezeichnete
Dateien ist möglich.

1 Markieren Sie ( ) das Kästchen
„Aufnahme einfügen“ im Fenster
[Fernbearbeitung].

2 Vergewissern Sie sich, dass Sie sich
an der rechten Position in der Datei
befinden, wo das Einfügen der
Aufnahme stattfinden soll.

3 Drücken Sie während der Datei-Wiedergabe
die REC-Taste des Directrec oder drücken
Sie die  (Aufnahmen)-Taste im
Fenster [Fernbearbeitung], um eine
zusätzliche Aufnahme einzufügen.
Die  rote Aufnahme/Wiedergabe-Kontrollleuchte
leuchtet am Directrec auf.

4 Drücken Sie die REC-Taste des Directrec
oder drücken Sie die  (Stopp)-
Taste im Fenster [Fernbearbeitung], um die
Einfügung der zusätzlichen Aufnahme zu
beenden.

3,4

......................................................................................................................................

Hinweise
• Vergewissern Sie sich, dass das Kästchen „Aufnahme  einfügen“ im Fenster

[Fernbearbeitung] markiert ist, da ansonsten die Aufnahme nicht eingefügt wird.
• Beim Überschreiben von Daten müssen Sie unbedingt die Aufnahmeart (SP, LP) für die

ursprüngliche Datei beibehalten.

Direktes Aufnehmen

3 4

1



17

1 Drücken Sie zum Abspielen die PLAY-
Taste des Directrec oder drücken Sie
die  (Wiedergabe)-Taste im
Fenster [Fernbearbeitung].
Die grüne Aufnahme/Wiedergabe-Kontrollleuchte
auf dem Directrec leuchtet auf.

2 Stellen Sie den Lautstärkeregler im
Fenster [Fernbearbeitung] auf die
gewünschte Lautstärke ein.
Die Aufnahme wird über den Lautsprecher
des Directrec abgespielt.

3 Drücken Sie zum Stoppen der
Wiedergabe an einer beliebigen Stelle
die PLAY-Taste des Directrec oder
drücken Sie die  (Stopp)-Taste
im Fenster [Fernbearbeitung].

1,3

Wiedergabe (Abspielen einer Diktatdatei)

Wiedergabe
Schieber
Der Wiedergabe
Slider zeigt die
gegenwärtige
Wiedergabeposition

Zeitachse

Bisherige
Wiedergabezeit

Gesamtaufnahmezeit
der aktuell

wiedergegebenen Datei

2

3 1
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Wiedergabefunktionen

• Bitte beziehen Sie sich hinsichtlich weiterer Informationen zu den Funktionen und zum
Betrieb des Directrec auf unsere Online-Hilfe (�S.8).

Mit dem Directrec und dem Fenster [Fernbearbeitung] sind verschiedene
Funktionen verfügbar, um eine aufgenommene Datei abzuspielen.

Wiedergabefunktionen des Directrec

Funktionen, die das Fenster [Fernbedienung] verwenden

Bedienvorgang

Drücken Sie die FF-Taste einmal
bei Betriebsstopp.

Drücken Sie die REW -Taste einmal
bei Betriebsstopp.

Halten Sie FF-Taste bei
Betriebsstopp oder Wiedergabe
einer Datei gedrückt.

Halten Sie REW-Taste bei
Betriebsstopp oder Wiedergabe
einer Datei gedrückt.

Annullierung

Drücken Sie die PLAY-Taste.
➥ Der Directrec beginnt den

Betrieb an der eingestellten
Position.

Lassen Sie die FF-Taste los.

Lassen Sie die REW-Taste los.

Wiedergabe-

funktionen
Schnellvorlauf
(FF)

Rücklauf
(REW)

CUE-Funktion
(CUE)

Schnell-
abhörkontrolle
(REV)

Bedienvorgang

Drücken Sie die  -Taste einmal
bei Betriebsstopp.

Drücken Sie die  -Taste einmal
bei Betriebsstopp.

Halten Sie  -Taste bei
Betriebsstopp oder Wiedergabe
einer Datei gedrückt.
Halten Sie  -Taste bei
Betriebsstopp oder
Wiedergabe einer Datei gedrückt.

Annullierung

Drücken Sie die  -Taste.
➥ Die aufgezeichnete Datei

wird erneut wiedergegeben.

Lassen Sie die  -Taste los.

Lassen Sie die  -Taste los.

Wiedergabe-

funktionen
Schnellvorlauf
(FF)

Rücklauf
(REW)

CUE-Funktion
(CUE)

Schnell-
abhörkontrolle
(REV)

Wiedergabe (Abspielen einer Diktatdatei)
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Aufnahme speichern

2,3
1 Um die aktuelle Aufnahme zu speichern,

drücken Sie die REC-Taste des Directrec
oder drücken Sie die  (Stopp)-Taste
im Fenster [Fernbearbeitung], um die
Aufnahme zu stoppen.

2 Drücken Sie die NEW-Taste des Directrec
oder klicken Sie auf das symbol  auf der
symbolleiste im Fenster [Fernbearbeitung].
Das Fenster [Datei sichern] erscheint, um die
Daten zu speichern.

3 Um die Daten zu speichern, drücken Sie
entweder die NEW-Taste auf dem
Directrec oder klicken Sie auf die Taste
[Speichern] im Fenster [Fernbearbeitung].
Die aufgenommenen Daten werden gespeichert.

4 Der Directrec ist nun bereit auf einer neuen
Datei eine Aufzeichnung zu beginnen.
Drücken Sie die REC-Taste des Directrec
oder drücken Sie die  (Aufnahme)-
Taste im Fenster [Fernbearbeitung], um
mit der Aufnahme zu beginnen.

Dateinummer... Eine vom Directrec zugewiesene laufende Nummer.

Die am Directrec eingegebene Kennung. Die werkseitige Vorgabe ist
„DR_1000“. Die Autorenkennung lässt sich mittels DSS Player ändern (�S.25-27).

Dateinamen werden folgendermaßen zugewiesen.

Dateinamenformat

DR_1 0001.dss
Erweiterung

1,4

3
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Die Mikrofonempfindlichkeit ist auf die Aufnahmeerfordernisse einstellbar.

Mikrofonempfindlichkeit

Es stehen mit dem Directrec zwei Aufnahmemodi zur Verfügung: SP
(Standard-Wiedergabe) und LP (Langzeit-Wiedergabe).

Aufnahmearten

1 Wählen Sie aus dem Kästchen „Empfindlichkeit“ entweder
„Diktat“ oder „Konferenz“ im Fenster [Fernbearbeitung].
Konferenz: Der hochempfindliche Modus, der geeignet ist, um Außengeräusche

    aufzunehmen.
Diktat: Der weniger empfindliche Modus, der zur Aufnahme von Diktaten geeignet ist.

......................................................................................................................................

Hinweis
• Für besonders klare Aufzeichnungen von Diktaten  schalten Sie auf Dictation-Modus um

und platzieren das interne Mikrofon nahe (5 bis 10 cm) beim Diktierenden.

1 Wählen Sie aus dem Kästchen „Hohe“ entweder „SP (mono)“
oder „LP (mono)“ im Fenster [Fernbearbeitung].
SP: Voreingestellter Aufnahmemodus.
LP: Kann in der gleichen Zeit wie im SP-Modus in einer kleineren Dateiengröße
     aufnehmen.

......................................................................................................................................

Hinweis
• Wählen Sie den SP-Betrieb zur Aufzeichnung des Inhalts von Konferenzen oder Vorträgen.

1

1
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In einer Datei lassen sich während der Aufnahme oder Wiedergabe
Indexmarken setzen, um das schnelle und einfache Auffinden von
wichtigen Passagen in der Datei zu erleichtern.

Indexmarken

Setzen einer Indexmarke

......................................................................................................................................

Hinweise
• Bis zu 16 Indexmarken lassen sich in einer Datei setzen.
• In einer gesperrten Datei lassen sich Indexmarken weder setzen noch löschen. Bitte

beziehen Sie sich zu weiteren Einzelheiten auf die Online-Hilfe (�S.8).

1
1 Drücken Sie entweder die A -Taste auf

dem Directrec oder klicken Sie während
der Aufnahme oder Wiedergabe  auf
das Symbolauf der Menüleiste im Fenster
[Fernbearbeitung].
Eine Indexmarke wird nun gesetzt.
Das Symbol  erscheint auf der
Zeitachsenanzeige im Fenster [Fernbearbeitung].
Die Indexmarke kann ebenfalls durch die Auswahl
von [Neue Indexmarke] im Menü [Extras].

Zeitachse

Wiedergabe Schieber
Zeigt die aktuelle
Position der Wiedergabe
oder Aufnahme an.

1
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Indexmarken

1

1 Drücken Sie entweder zweimal die
Taste FF oder REW auf dem Directrec,
oder klicken Sie auf die  -Taste
im Fenster [Fernbearbeitung].

Der Schieberegler „Abspielposition“ springt
automatisch auf die Position der Indexmarke ( ).

Auffinden einer Indexmarke

Das Symbol  auf der Zeitachsenanzeige im Fenster [Fernbearbeitung]
zeigt die Position der Indexmarke an. Um zu einer markierten Position
zu springen, folgen Sie diesem Ablauf.

1 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung]. Oder wählen Sie [Alle Indexmarkierungen
anzeigen...] im Menü [Extras].
Das Fenster [Indexmarkierungen aufli...] erscheint.

2 Wählen Sie die markierte Position, auf die Sie springen möchten
und klicken Sie auf [Überspringen].
Der Directrec springt auf die gewählte Position der Indexmarke.

Verwenden Sie das Fenster [Indexmarkierungen aufli...], um auf die Indexmarke zu springen.

Position der Indexmarke

Zeitachse

1

2
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1 Wählen Sie die zu löschende Indexmarke.

2 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung]. Oder wählen Sie [Indexmarkierung löschen]
im Menü [Extras].
Daraufhin wird die Indexmarke gelöscht.

Löschen von Indexmarken

......................................................................................................................................

Hinweis
• In einer gesperrten Datei lassen sich Indexmarken weder setzen noch löschen. Bitte

beziehen Sie sich zu weiteren Einzelheiten auf die Online-Hilfe (�S.8).
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1 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung]. Oder wählen Sie [Directrec Configuration
Tool] im Menü [Extras].
Das Dialogfenster [Directrec Configuration Tool] erscheint.

2 Wählen Sie das Register [Benutzerorientiert] und markieren  das
Kästchen [Piepton aktivieren].

Mir Markierung: Der Systemton ist ein.
Ohne Markierung: Der Systemton ist aus.

3 Klicken  Sie auf [Einstellungen hochladen].
Die Einstellungen sind nun abgeschlossen.

Systemton

Durch einen Ton bestätigt der Directrec die Betätigung von
Bedienelementen. Die Systemtonwiedergabe lässt sich ausschalten.

1

2 3
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Eingabe von zusätzlichen
Benutzerinformationen

Die durch den Directrec auf Ihrem PC aufgenommenen Dateien
beinhalten die Autorenkennung und die Themakennung als Kopfdaten.
Die Einzelheiten in den Kopfdaten können mittels des DSS Players leicht
geändert werden.

Registrierung der Autorenkennung und der
Themakennung im DSS Player

Es können auf dem DSS Player bis zu zehn Benutzerkennungen und
zehn Themakennungen  registriert werden.

1 Vergewissern Sie sich, dass der Directrec nicht angeschlossen ist.

2 Wählen Sie aus dem DSS Player Hauptfenster das [Download]
Menü, wählen Sie dann [Job-Daten erstellen und senden].
Das Fenster [Job-Daten erstellen und senden] erscheint.
Geben Sie Ihre Autorenkennung oder Themakennung in dem durch den Pfeil
angezeigten Feld ein.

3 Klicken Sie die Taste [Speichern].
Die Registrierung der Autorenkennung und Themakennung ist nun
abgeschlossen.

Autorenkennung

Themakennung

3
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Eingabe von zusätzlichen Benutzerinformationen

Voreingestellte Benutzerkennung auf dem Directrec

Die Benutzerkennung des Directrec spielt eine wichtige Rolle im
Dateibenennungs-Verfahren neuer Aufnahmen. Die voreingestellte
Benutzerkennung ist „DR_1000“. Um die voreingestellte Benutzerkennung zu
ändern, halten Sie sich an den unten beschriebenen Ablauf.

1 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung]. Oder wählen Sie [Directrec Configuration
Tool]  im Menü [Extras].
Das Dialogfenster [Directrec Configuration Tool] erscheint.

2 Geben Sie Ihre Benutzerkennung in der [Benutzername] -Box
ein und klicken Sie auf [Einstellungen hochladen].
Die eingegebene Benutzerkennung wird auf den Directrec übermittelt. Bei
der Kennung kann es sich um eine beliebige Kombination aus   „A“ bis „Z“,
Nummern und/oder „_“ handeln, die bis zu 16 Buchstaben lang sein kann.

......................................................................................................................................

Hinweis
• Trennen Sie niemals den USB-Anschluss, wenn die Anzeigeleuchte rot aufblinkt.

Andernfalls können die Daten zerstört werden.

1

2
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rmationen

Eingabe einer Autorenkennung

1 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung].
Das Fenster [Job-Daten bestimmen] erscheint.

2 Wählen Sie die gewünschte Autorenkennung aus der Box mit
der Autoren-ID aus.

3 Klicken Sie die Taste [OK].
Alle Aufnahmen, die von einem Autor während einer Sitzung gemacht wurden,
enthalten die eingestellte Kennung als Teil der Kopfzeile.

Es können entweder die voreingestellte Autorenkennung auf dem
Directrec oder jede auf einem DSS Player registrierte Autorenkennung
(�S.25) als Kopfdaten eingestellt werden.

......................................................................................................................................

Hinweis
• Die voreingestellte Benutzerkennung des Directrec ist „DR_1000“.

1

2 3
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Eingabe einer Themakennung

Jede auf dem DSS Player registrierte Themakennung (�S.25) kann
als Kopfdaten eingestellt werden.

1 Wählen Sie die registrierte Themakennung in der Einstellung der
Arbeitsart-ID im Fenster [Fernbearbeitung] aus.
Alle Aufnahmen, die mit der neuen Themakennung erstellt werden, enthalten
das neue Thema als Teil der Kopfzeile.

1

Eingabe von zusätzlichen Benutzerinformationen
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1 Wählen Sie [Directrec Configuration Tool] aus dem Menü [Extras]
im Fenster [Fernbearbeitung] aus. Oder klicken Sie auf das
Symbol  in der Menüleiste.
Das Dialogfenster [Directrec Configuration Tool] erscheint.

2 Wählen Sie die anzupassenden Funktionen für jede Taste aus
und klicken Sie auf [Einstellungen hochladen].
Der „Einstellungen erfolgreich hochgeladen“-Alarm erscheint und schließt die
 Anpassung ab.
Falls der „Hochladen der Einstellungen fehlgeschlagen“-Alarm erscheint,
so versuchen Sie den Einstellungs-Ablauf erneut.

Funktionsanpassung einer Taste
des Directrec

Durch die Verwendung von [Directrec Configuration Tool] können die
Funktionen der Tasten des Directrec auf einfache Art und Weise an die
Bedürfnisse jedes einzelnen Nutzers angepasst werden.

Anpassung der Tasten des Directrec

1

2
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Funktionsanpassung einer Taste des Directrec

Liste der anpassbaren Tasten

REW

PLAY

FF

NEW

REC

A

B

Voreingestellte Einstellungen

REW

PLAY

FF

NEW

REC

Application (INDEX/DSS Player)

Application (EXIT)

Für die Einstellungen zur
Verfügung stehende Funktionen
REW, PLAY, FF, NEW,

INDEX*1, PRIORITY*2,

INSERT/OVERWRITE*3,

DISABLE*4, Application...*5

*1: [INDEX]-Tastenfunktion...Zum Einsetzen einer Indexmarke mittels des Fensters [Fernbearbeitung].
*2: [PRIORITY]-Tastenfunktion...Zum Ändern der „Priorität“-Einstellung im Fenster [Fernbearbeitung].

*3: [INSERT/OVERWRITE]-Tastenfunktion...Zum Ändern der Modi für das Einfügen und Überschreiben
von Aufnahmen im Fenster [Fernbearbeitung].

*4: [DISABLE]-Tastenfunktion...Es wird keine Funktion zugeordnet.

*5: [Application...]-Tastenfunktion...Zum Programmieren des Starts einer Schnelltaste für den DSS
Player und einer gewählten Anwendung mittels des Registers [Directrec APP].
Beispiel: (EXIT) zeigt an, dass die Schnelltaste für den Befehl zum Beenden im Fenster
[Fernbearbeitung] zugewiesen ist. Wenden Sie sich für eine Registrierung an die Online-Hilfe.

Liste der anpassbaren Tasten und verfügbaren Funktionen

Anzeige programmierbarer Tasten
Die programmierbaren Tasten (A,B) des Directrec können im Fenster
[Fernbearbeitung] angezeigt werden. Sie sind insofern hilfreich, als dass
die programmierten Funktionen ebenfalls angezeigt werden.

1 Wählen und markieren Sie das Kästchen [Angepasste Taste
anzeigen] im Menü [Extras] im Fenster [Fernbearbeitung].
Die programmierbaren Tasten (A,B) Knöpfe werden zusammen mit ihren
programmierten Funktionen in der Menüleiste angezeigt.

......................................................................................................................................
Hinweis
• Die programmierbaren Tasten werden nicht angezeigt, wenn das angeschlossene Gerät

nicht über die gleichen Funktionstasten verfügt.

1
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rectrec

1 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung]. Oder wählen Sie [Directrec Configuration
Tool] im Menü [Extras].
Das Dialogfenster [Directrec Configuration Tool] erscheint.

2 Wählen Sie das Register [Directrec App] im Dialogfenster
[Directrec Configuration Tool].
Die Schnelltasten für das Fenster [Fernbearbeitung], die auf jede Taste des Directrec
programmiert sind werden ebenso wie jede Startanwendung angezeigt.

Programmierung von Schnelltasten (Registrierung)
Die gewählten Anwendungs-Schnelltasten können als programmierbare (A,B)
Tasten des Directrec mittels des [Directrec Configuration Tool] programmiert
werden. Somit können nach dieser Ausführung die Tasten des Directrec
verwendet werden, um die Anwendungen zu starten und die Funktionen zu
bestimmen.
Das Symbol  wird auf der Taskleiste als eine reguläre Anwendung im [Directrec
Configuration Tool] angezeigt.

Programmierung [Fernbearbeitung] Funktion (voreingestellt)

Die Schnelltasten im Fenster [Fernbearbeitung] im DSS Player sind ab
Werk vorprogrammiert.

1

2
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Funktionsanpassung einer Taste des Directrec

Programmierbare (A,B) Tasten des Directrec ebenso wie das Fenster
[Fernbearbeitung] können verwendet werden, um die Anwendungen zu steuern
und durch sie durchzunavigieren, wenn diese individuell als Anwendungs-
Schnelltasten programmiert sind.
Die Schnelltasten für die Anwendungen können individuell als Schablone
gespeichert werden. Da eine Schablone automatisch umgestellt werden kann,
wenn die Anwendung aktiv wird, können die verschiedenen Anwendungen,
falls nötig, über eine Fernsteuerung betrieben werden.

1 Klicken Sie auf das Symbol  in der Menüleiste im Fenster
[Fernbearbeitung]. Oder wählen Sie [Directrec Configuration
Tool] im Menü [Extras].
Das Dialogfenster [Directrec Configuration Tool] erscheint.

2 Klicken Sie auf das Symbol  in der Menüleiste im Fenster [Directrec
Configuration Tool]. Oder wählen Sie [Neue Vorlage] im Menü [Datei].
Das Dialogfenster [Open] erscheint.

Taste

A

B

Shift+FF

Shift+NEW

Shift+A

Shift+PLAY

Shift+REC

Zugewiesener Befehl

Application (zum Setzen einer Indexmarke/Bedienung des DSS Players)

Application(Das Fenster Fernbearbeitung verlassen oder Hauptfenster)

Auf die Indexmarke springen

Zur Erhöhung der Lautstärke

Zur Verringerung der Lautstärke

Priorität

Abwechselnd zum Einfügen/Überschreiben einer Aufnahme

Die voreingestellten, programmierten Schnelltasten werden unten aufgezeigt.

Nur die programmierbaren (A,B) Tasten können programmiert werden. Eine
Programmierung der Tasten NEW, REW oder FF ist nicht möglich. Jedoch ermöglicht
die Kombination aus der Shift-Taste oder Ctrl-Taste des PCs ein Programmieren.

 Programmierung von Schnelltasten auf Ihre gewünschte Anwendung

2
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3 Durchsuchen und wählen Sie die ausführbare Anwendung und
klicken Sie auf [Open].
Die Abküzung ist nun eingestellt.
Wenn Sie beispielsweise Microsoft Word „winword.exe“ auswählen, so wird die
ausführbare Datei „winword“ der Dialogfenster [Directrec Configurtion Tool] hinzugefügt.

4 Wählen Sie das der Dialogfenster [Directrec Configuration Tool]
hinzugefügte Register und programmieren Sie die Schnelltaste
auf den programmierbaren (A,B) Tasten des Directrec.
Die registrierten Inhalte werden automatisch als Schablone gespeichert. Es
ist mit der Kombination aus der Shift-Taste oder der Ctrl-Taste des PCs
möglich, auf den Tasten nicht-programmierbare Tasten zu programmieren.

Beziehen Sie sich zu weiteren Informationen zur Programmierung von
Schnelltasten auf die Online-Hilfe (�S.8).

A:Die Spalte [Taste] zeigt die Tasten des Directrec auf. Shift+XXX und
Ctrl+XXX zeigt die Kombination aus der Shift-Taste oder der Ctrl-Taste auf
der Tastatur und den Tasten des Directrec an.

B:Die Spalte [Zuweisen] zeigt die aktuell programmierten Schnelltasten oder
den Status der Autostart-Anwendung.

rectrec
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Fehlersuche

Für neueste, nicht in der Bedienungsanleitung enthaltene Information
siehe bitte die Online-Hilfe (�S.8).

Symptom

Nicht möglich die
Steuerung des
Directrec zu
verwenden

Keine
Klangwiedergabe

Verrauschte
Klangwiedergabe

Aufnahmepegel
zu niedrig

Setzen von Index
Marken unmöglich

Anschluss an PC
nicht möglich

Verwendung des
USB-Mikrofons/-
Lautsprechers
des Directrec
nicht möglich.

Mögliche Ursache

Der DSS Player (im Paket
enthalten) ist nicht installiert.

Das Fenster [Fernbearbeitung]
im DSS Player (im Paket
enthalten) ist nicht geöffnet.

Die Lautstärke im Fenster
[Fernbearbeitung] ist auf 0
gestellt.

Die Lautstärke Ihres
Computers ist auf 0 gestellt.

Der Directrec war während
der Aufnahme
Erschütterungen ausgesetzt.

Der Directrec befand sich
während der Aufnahme oder
Wiedergabe neben einem
Handy oder einer
Fluoreszenzlampe.

Die Mikrofonempfindlichkeit
ist zu niedrig.

Die maximale Zahl von
Indexmarken (16) ist erreicht.

Manchmal kann keine
Verbindung zu einigen PCs
hergestellt werden, die
Windows XP verwenden.

Das USB-Audio-Gerät wurde
in den Geräteeinstellungen
Ihres PCs nicht ausgewählt.

Abhilfemaßnahme

Installieren Sie den DSS
Player (�S.6).

Öffnen Sie zuerst das Fenster
[Fernbearbeitung] und
verwenden Sie dann den
Directrec.

Regulieren Sie die
Lautstärketaste.

Stellen Sie den Directrec an
einen anderen Ort.

Die Mikrofonempfindlichkeit
auf „Conference“ stellen und
erneut versuchen (�S.20).

Nicht benötigte Indexmarken
löschen (�S.23).

Die USB-Einstellungen des
PCs sind zu ändern. Näheres
hierzu siehe in der Online-Hilfe
von DSS Player (�S.8).

Gehen Sie zum Windows [Start]
Menü, = [Systemsteuerung] und
wählen Sie dann [Sound und
Multimedia]. Öffnen Sie das
Register [Audio] und wählen Sie
USB-Audio-Gerät als die
Einstellung für  „Standardgerät“
und „Standardgerät“.
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Aufnahmeformat: DSS (Digital Speech Standard)

Eingangspegel: –70 dBv

Gesamtfrequenzgang: 100 bis 15.000 Hz

Maximale Ausgangsleistung (bei 5 V Gleichspannung):
Mindestens 300 mW oder mehr (8 Ω-Lautsprecher)

Abmessungen: 157 x 49 x 27 mm (ohne vorstehende Teile)

Gewicht: 200 g

Kabellänge: 2,5 m

Steckerform: USB-Anschluss A-Typ

Technische Daten

�Für Kunden in den USA und Kanada
Telefon: 1-888-553-4448
E-mail: distec@olympus.com

�Für Kunden in Europa
E-mail : dss.support@olympus-europa.com

Technische Hilfe und Support
DR-1000 ist Teil des Olympus Professional Dictation System. Die
meisten der möglichen Störungen können vom Händler behoben
werden. Im Fall von Störungen beim Gebrauch des DR-1000 wenden
Sie sich bitte zunächst an den Olympus-Fachhändler, bei dem das
Gerät bezogen wurde. Kann dieser Ihr Problem nicht lösen, so rufen
Sie bitte unsere Hotline-Nummer an oder schicken uns eine E-Mail.
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Declaration of Conformity
Model Number: DR-1000
Trade Name: DIRECTREC
Responsible Party: OLYMPUS IMAGING AMERICA INC.
Address: 2 Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A.
Telephone Number: 800-622-6372

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device
may not cause harmful interference, and (2) this device must accept any interference received, including interference
that may cause undesired operation.

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
Canadian RFI
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus as set out in the Radio Interference Regulations of the Canadian Department of
Communications.
Cet appareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio
émanant d’appareils numériques, tel que prévu dans les Règlements sur l’Interférence Radio du
Département Canadien des Communications.

“CE” mark indicates that this product complies
with the European requirements for safety,
health,environment and customer protection.

For customers in North and South America

For customers in Europe

Das „CE“ Zeichen bestätigt die
übereinstimmung mit den Europäischen
Bestimmungen für
Betriebssicherheit und Umweltschutz.

This symbol [crossed-out wheeled bin WEEE
Annex IV] indicates separate collection of
waste electrical and electronic equipment in
the EU countries.
Please do not throw the equipment into the
domestic refuse.
Please use the return and collection systems
available in your country for the disposal of
this product.
Applicable Product : DR-1000

L’indication “CE” signifie que ce produit est
conforme aux exigences concernant la
sécurité, la santé, l’environnement et la
protection du consommateur.

Le symbole [poubelle sur roue barrée d’une
croix WEEE annexe IV] indique une collecte
séparée des déchets d’équipements
électriques et électroniques dans les pays de
L’UE.
Veuillez ne pas jeter l’équipement dans les
ordures domestiques.
A utiliser pour la mise en rebut de ces types
d’équipements conformément aux systèmes
de traitement et de collecte disponibles dans
votre pays.
Produit applicable : DR-1000

Dieses Symbol [durchgestrichene Mülltonne
nach WEEE Anhang IV] weist auf die getrennte
Rücknahme elektrischer und elektronischer
Geräte in EU-Ländern hin. Bitte werfen Sie
das Gerät nicht in den Hausmüll. Informieren
Sie sich über das in Ihrem Land gültige
Rücknahmesystem und nutzen dieses zur
Entsorgung.
Anwendbare Produkte: DR-1000


